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ABSTRACT

The Gamma Detector Response and Analysis Software — Detector Response Function (GADRAS-
DRF) application computes the response of gamma-ray and neutron detectors to incoming radiation
and provides analysis on measured spectra. This manual provides step-by-step procedures to
acquaint new users with the use of the application. The capabilities include characterization of
detector response parameters, plotting and viewing measured and computed spectra, analyzing
spectra to identify isotopes, estimating source energy distributions from measured spectra, and
creating inject data. GADRAS-DRF can compute and provide detector responses quickly and
accurately, giving users the ability to obtain usable results in a timely manner (a matter of seconds or
minutes).
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ACRONYMS AND DEFINITIONS

Abbreviation Definition

GADRAS GAmma Detector Response and Analysis Software

GADRAS-DRF GAmma Detector Response and Analysis Software Detector Response
Function

SNM Special Nuclear Material

1D One Dimensional

3D Three Dimensional

FSA Full Spectrum Analysis

FWHM Full-Width at Half-Maximum

keV Kilo-electron-Volts

MeV Mega-electron-Volts

LLD Lower-Level Discriminator

Nal Sodium Iodide

HPGe High-Purity Germanium

CZT Cadmium Zinc Telluride

PVT Polyvinyl Toluene

AN Atomic Number

AD Areal Density

AC Anti-Coincidence

Ci Curies

Bq Bequerels

MCNP Monte Carlo N-Particle
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1. INTRODUCTION

1.1. GADRAS Overview

GAmma Detector Response and Analysis Software (GADRAS) contains a suite of capabilities
related to radiation detection [1]. Its primary function is the simulation of gamma-ray and neutron
detector signals to radiation sources. It also contains various analysis tools and radiation transport.

Features in a gamma-ray detector spectrum; such as photopeaks and the Compton continuum, are
derived from first-principles calculations based on interaction cross sections. Neutron detector
response is computed by interpolating on a pre-computed database of thermal (3He) detector
responses [5] [6]. For both gamma-ray and neutron detectors, the response to radiation that scatters
into the detector from the surrounding environment is determined by a combination of first-
principles calculations and empirical modeling [7]. For new detectors, known detector parameters
such as size and resolution are all that is necessary to compute an initial response function. This
response function may be refined by measuring calibration sources and fitting the detector's
parameters to match the data. After the initial characterization, GADRAS will interpolate and
extrapolate the response to model different source energies, complex models, and different
scattering environments.

GADRAS uses the detector response in combination with various analysis algorithms to analyze
measurement data to identify sources, quantify activities, and determine shielding types and
thicknesses. Because the entire spectrum is utilized, as opposed to just photopeaks, this is called full-
spectrum analysis (FSA).

There are also several radiation transport methods available in GADRAS. The primary feature is
one-dimensional (1D) source modeling, where users can construct nested-spherical-shells, and solve
for the gamma and neutron leakage. There is support for three-dimensional (3D) models as well.

The full version of GADRAS is for official use only, export controlled, and limited to government
agencies and their contractors. GADRAS-DRF (GADRAS-Detector Response Function) is a
reduced capability version that is publicly available. The following key features are not available in
GADRAS-DRF:

• IsotopelD — algorithm that automatically identifies the sources in a gamma spectrum

• SNMAnalysis — analysis designed to estimate isotopic composition and masses from gamma
spectrum of special nuclear material (SNM)

• ModelFitFSA — algorithm that uses non-linear regression to fit the parameters of a model to
match the model's simulated gamma spectrum to a measurement

• 1D Models — the model page allows users to build models and solve the radiation transport
to determine leakages

• 3D Models — the effects from offsetting sources in 3D, detector collimator effects,
simulating 3D models, and gamma-imager simulations

Screenshots in this manual reference the full GADRAS version; however, some depicted features
and pages may not appear in the GADRAS-DRF version.
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Figure 1 is a screen-capture of the GADRAS main window. The program contains eight main tabs
that run across the top of the window (Detector, Plot, Time History, Analyze, Model, Neutron,
Inject, Tools, and Setup). Each tab represents a primary function of GADRAS; these are referred
to as tabs in this document (e.g. Plot tab). Most tab pages have a primary function initiated by
clicking a large button in the bottom right corner of the screen. The title of the main window
displays the current version and currently selected gamma-ray detector. GADRAS must always have
a current gamma-ray detector selected, even if the current operation does not require a detector
response function (e.g. plotting a measured spectrum). Neutron detectors are optional; the current
neutron detector name will also appear in the main window title if selected.

Version and
Current Detector

GADRAS 1$.8.0 3:0.Nal MidScat

Detector Plot

File ifools Help

Measurements

Tab ages

Time History Analyze Model Neutron lnjec: Tccls Setup

Add SpecPair Delete SpecPair

Computed Sources

Source Detector Distance Height

Add Source Delete Source

Plot

Figure 1. Overview of Main Window

"Action" Button
for Current Tab
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1.1 Directory Structure

Within the root GADRAS directory (default is C: \GADRAS, or C: \ GADRAS-DRF), there are four
primary directories: (1) Detector, (2) Source, (3) Temp, and (4) Program (Figure 2).

Data Libraries

(1) Detector

(2) Source

(3) Temp

(4) Program

Gamma Detectors

Common Source
Definitions

Log Files

Temporary Files

Documentation

Executable and DLLs

Detector Response

Neutron Response

Measured Data

Source Definitions

API Examples

Application Manual

Figure 2. Overview of GADRAS Directory Structure

The Detector directory contains subdirectories, each for a different gamma-ray detector. The name
of the subdirectory indicates the name of the detector; thus, each gamma-ray detector requires its
own directory. However, multiple neutron detectors can be added to a single gamma-ray detector
directory. A common practice is to use a gamma-ray detector directory as a scenario or experiment
repository containing documents and measured spectra. Therefore, detector directory names are also
based on experiments (e.g. "GADRAS \Detector \BeRPBall").

Common source files shared among multiple detectors are stored in the Source directory. Source
files may be stored in individual detector directories as well.

The Temp directory is cleaned with each new instance of GADRAS. It contains temporary files
which facilitate faster operation of the program as well as log files which record debugging
information. Most users will not need to explore this directory.

The main executable is located in the Program directory at "GADRAS \Program \ GADRAS.exe"
along with associated shared libraries. This also contains a Documentation directory which
contains this user's manual as well as example codes that utilize the GADRAS API.
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2. DETECTOR RESPONSE FUNCTION

2.1. Creating New Detectors

Each detector directory contains a file named Detector.dat, which contains the response function
parameters. Response function parameters do not normally require adjustment after initial
characterization. Specific situations where parameter adjustments are necessary include:

• adjustments needed due to mechanical damage, chemical deterioration, high voltage bias
change, shielding, etc. that have caused the detector to change its characteristics
substantially; and

• drastic changes in the measurement environment from which the detector was characterized
(e.g. moved from a room to outdoors).

2.1.1. Using the Create New Detector Screen: Clone or Create Options

A new detector setup within GADRAS can be created from the Detector tab on the main window.
To create a new detector, the user selects Create New Detector... from the drop-down menu as
shown in Figure 3 (top). This action opens the Create New Detector form shown in Figure 3
(bottom), which allows users to clone an existing detector or create a new detector.

The following entries are mandatory for creating new detector setups:

1) Detector name: Users should create a unique name for the detector.
2) Parent directory: The parent directory for the detector. By default, this is the main detector

directory "GADRAS \Detectoe'. Any subdirectory of the main detector directory may be used
(including existing detector directories) to be the new detector's parent directory.

3) Source-to-detector distance: This is the distance (cm) between the detector and calibration
sources. A value must be entered upon detector creation, but this value can be modified at any
time if needed. The value is given in centimeters, but other units may be used (see Section 2.2).
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Figure 3. File Drop-down Menu (top) for Create New Detector Dialog (bottom)
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New detectors may be created by clicking the Clone button located in the middle of the window or
the Create button located near the bottom of the window.

1) Clone: An existing detector is copied using either the provided dropdown list or the Browse
button. After choosing the appropriate detector, clicking the Clone button will create the new
directory with the appropriate Detector.dat file.

2) Create: This option generates a new Detector.dat file. Select the detector type (e.g. NaI, HPGe,
etc...) from the dropdown list. The number of channels and the detector efficiency or detector
dimensions should be entered, depending on the type of detector. The Length dimension is
along the line defined by the two points: (1) the center of the source and (2) the center of the
front face of the detector. This is also referred to as depth. The height and width define the
front face dimensions. The user can then click the Create button to create the new directory
with the appropriate Detector.dat file.

GADRAS assumes a rectangular prism for the detector shape. If the detector's front face is
circular, enter the diameter in the width and height fields. With the cursor still in the fields, press
the "cr key to convert each to a side length that preserves surface area.

When creating an HPGe detector, the user can enter the relative efficiency of the detector

compared to a standard 3"x3" NaI detector at 1332.5 keV with a source-to-detector distance of
25 cm. GADRAS will subsequently assign typical physical dimensions.

Selecting None for the detector type will simulate a perfect radiation detector. Computed source
spectra will be composed of the leakage current from the source and the solid angle of the
detector. No peak broadening or any other physics associated with a real detector are applied.

NOTE: It is advisable to always work with clones of distributed Detector.dat files as opposed
to modifying the original. Working on original files may compromise them.
Furthermore, each release and install of GADRAS will overwrite any changes to the
original files.

2.2. Detector Parameters in Detector.dat Files

From the Detector tab, the detector response function parameters can be observed and edited. The
detector response function parameters are displayed in Figure 4 for a NaI detector. For other
detector types, similar screens are displayed with some detector-specific variations.

Dimensions and distances can be entered in the following units: centimeters, meters, feet, or inches.
GADRAS will convert all inputs to cm when the correct conversion letter is typed in the text box.
The identifiers for meters, feet, and inches are "m", "f', and "T, respectively. For example, to enter
12 inches as the distance, you would type "12i" into the distance entry box; unit conversion is
performed automatically so that distance is displayed in centimeters after typing the character "T.
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The following sections briefly describe the function of each field on the Detector tab. For more
information, see reference [8].

GADRAS 18.8.0 lakNal MidScat El x
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Low-E Skew Power

Tming Computation Options Height (cm) 56
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Skew Eictent +/- Shape Time (ps) Replace Ecal in All Files
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LLD Sharpness

Miscellaneous

34

Shield / Collimator

Fluorescence X-rays

Coincidence / imaging Calibrate

Figure 4. Example Detector Response Function Parameters for a Nal Detector

2.2.1. Detector Dimensions

The following parameters describe the detector dimensions:

• Setback is the distance in cm from the physical surface of the detector face to the active
sensor element (crystal).

• Length is the detector length in cm measured perpendicular to the detector face and is also
referred to as depth.

• Width is the detector width in cm measured perpendicular to the incident photon flux and
parallel to the floor.

• Height/Width is the ratio of the two dimensions perpendicular to Length.
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NOTE: If describing a detector system with an array of detectors and the measured spectra
are simple sums of each detector's observation, the dimensions describe the size of
one of the detectors. Use the Scalar parameter described below to add multiple
detectors to a system.

Although these parameters describe a rectangular detector, other geometries can be
approximated using these dimensions. For example, a cylindrical detector oriented so that the
axis is pointed toward the radiation source can be approximated by a square with the same
surface area as the circle (i.e., height X width = zr2). The conversion between diameter and
width can be performed by typing "X' after specifying the numerical value for the diameter.

• Shape Factor is a parameter describing the distribution of path lengths through which
incident radiation travels as it traverses the detector. The shape factor describes a continuous
function that varies from about 3 for circular cross sections (e.g. radiation enters
predominantly through side of a cylindrical detector) to about 100 for flat detector profiles
(e.g. radiation enters through top or bottom of cylindrical detector). Figure 5 shows detector
profiles for several shape factor values. Note that the detector shape can vary depending on
the orientation of the radiation source with respect to the detector. In the case of a
cylindrical detector oriented so that the radiation source is located on the axis of the
detector, the value of S is about 100, which describes a flat profile.

1.00 -

_c
tt▪ o
aj • 0.80

o) • 0.60

0.40
tw
c
QJ

12 0.20

u

0.00

Distance from Axis (r) / Radius (R)

Figure 5. Detector Cross-section Profiles for Several Shape Factors

• Dead Layer (mm) describes the depth of the inactive region between the contacts and the
semiconductor in a solid-state detector. Typical values are a less than a few millimeters,
depending on the manufacturing technique employed. This primarily affects low-energy
intensities such as x-rays.
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• Scalar scales the total efficiency of the detector. This is typically used for detector system
arrays. The other dimensions describe the size of one detector, and this field can be the
number of detectors in the system.

2.2.2. Peak Shape

The full-width-at-half-maximum (FWHM) parameter describes the width of a photopeak and is
commonly referred to when describing the resolution of the detector. If detector energy resolution
followed Poisson statistics exactly, the FWHM of the peaks would increase as the square-root of
energy. However, the resolution of scintillators is often dominated by effects associated with
intrinsic nonlinearities. For semiconductor detectors, the resolution at the zero-energy FWHM
asymptote is limited by dark current. GADRAS uses an empirical form of the FWHM using as few
parameters as possible to describe a wide variety of detectors:

FWHM(E) =

6.61r( 
661
 E > 661

j[ro(66616-1 +
{6.61r(  

661 
)1312 E 661, r0 0

og (1 - r0)) 
- 1

6.61r
(maxi.) 

661 

1(20 , Et(
E 661, r0 <

(1)

where E is the photopeak energy in keV, r is the percent resolution at 661 keV, P is the FWHM

energy power (unitless), and rois zero-energy FWHM asymptote in keV. There is a discontinuity in
the resulting FWHM from Eq. (1) when the zero-energy asymptote is zero. Detector response
fitting will typically not cross that discontinuity and care must be taken to determine which regime
(positive or negative asymptote) the detector is best suited to.

The following parameters on the Detector tab are used to calculate peak shape and resolution:

• FWHM @ 0 (keV) zero-energy asymptote of the FWHM in keV (can be negative) (ro in
Equation 4)

• FWHM @661 (%) (or keV @ 1332) is the percent FWHM of the photopeak at 661 keV
(or for HPGe detectors, it is displayed as the width of the photopeak at 1332 keV in keV) (r
in Equation 4)

• FWHM Power describes the rate at which the FWHM increases as a function of energy (p
in Equation 4)

• Low-E Skew/Tail describes the magnitude of photopeaks' low energy tails

• High-E Skew/Tail describes the magnitude of photopeaks' high energy tails

• Low-E Skew Power describes the rate at which the low-energy tail decreases

• High-E Skew Power describes the rate at which the high-energy tail decreases

• Skew Extent +/- describes additional skew range relative to the nominal range

2.2.3. Lower Level Discriminator

• LLD (keV): The lower-level discriminator of the detector (low-energy cutoff) in keV is
represented by this setting.
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• LLD Sharpness: The simulated LLD is not a step-function; the slope of the simulated
spectrum at the LLD is determined by this parameter.

2.2.4. Miscellaneous

• Annih. Magnitude describes the magnitude of annihilation photons (511 keV) produced in
the vicinity of the detector. Annihilation inside the active detector area is modeled explicitly.
However, if high-atomic-number materials are used in the detector housing, additional
annihilation photons can be modeled with this parameter.

• Beta Magnitude provides the ability to estimate the continuum produced by
bremsstrahlung emission. A good first estimate for this parameter is 20.

• % Holes Trapped is used as an empirical term related to hole trapping by detectors such as
CdTe. This parameter does not have quantitative significance.

• Frisch grid %: Frisch grids are used in conjunction with some CZT detectors. The percent
of events that are recorded between Frisch grid electrodes is described by this parameter.
Events recorded in this region can produce up to twice the apparent full energy because
both electrons and holes are counted; whereas holes are excluded for interactions within the
bulk material.

NOTE: Except for limited cases, using the bremsstrahlung parameter is neither necessary nor
advised. If a more accurate representation is required, a radiation transport calculation
should be performed.

2.2.5. Default Energy Calibration

The default energy calibration will be used when a spectral file does not explicitly define an energy
calibration. Routine energy calibration is usually performed elsewhere in GADRAS. Adjusting the
energy calibration is discussed in Section 0.

These parameters are typically only used when simultaneously varying the energy calibration with
other detector response parameters during a characterization for plastic scintillators with no
photopeak definitions (e.g. PVT).

The most common energy calibration convention is to use polynomial coefficients. These
coefficients convert channel number into energy at the lower edge of the channel according to the
following equation:

E = co + c + c2i2 + c3i3 + c4i4 (2)

where i is the channel number (starting at 0), and cn is the n
th

 polynomial coefficient.

GADRAS uses the convention defined as the FullRangeFraction in ANSI N42.42-2006, which
represents energy calibration as follows:
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where an is the n
th

 polynomial term which corresponds to Cl/ in Eq. (1), and x is the fractional energy
of the spectral range. x ranges from 0 at the lower edge of the first channel and ends at 1 at the
upper edge of the last channel. If the spectrum has uniform energy groups, x = i/n, where n is the

total number of channels. The offset terms are identical in these definitions (i.e., ao = co), and the
higher order parameters are related as follows:

a. = nic. (4)

The final term in Eq. (3), which addresses nonlinearity in the low-energy region, does not have an

equivalent term in Eq. (2). However, neither a4 nor C4 is often applied, so this incompatibility is
rarely important.

There are a few general remarks about what values might be reasonable for the calibration of a
detector.

• Order 0 in Energy (offset): should a small number (<100) either positive or negative
• Order 1 in Energy (gain): should be a number close to the maximum energy scale of the

detector in keV
• Order 2 in Energy (quadratic): should be zero unless the detector is non-linear

• Order 3 in Energy (cubic): should be zero unless the detector is highly non-linear

• Low Energy: non-linear parameter for the low-energy region (usually zero)

In general, it is advised to initially have values only for the gain and offset. For more information on
how to calibrate spectral data, see Sections 3.3.4, and 0.

2.2.6. Inner Attenuator

This reduces the intensity of all incident radiation, including room scatter, before it passes into the active
detector volume. This is useful in describing detector housing.

• Atomic Number is the effective atomic number (AN) of the inner attenuator. This can be
an average of multiple materials.

• AD (g/cm2) is the areal density (in g/cm2) (density multiplied by thickness) of the
attenuator

• Porosity (%) allows for an attenuator with incomplete coverage around the detector

2.2.7. Outer Attenuator

This reduces the intensity of all direct radiation, not including room scatter. This is useful for describing
attenuation by a detection system placed in a large truck. The truck walls can be described by the
outer attenuator.

• Atomic Number is the effective atomic number (AN) of the outer attenuator.

• AD (g/cm2) is the areal density (in g/cm2) of the outer attenuator

• Porosity (%) allows for an attenuator with incomplete coverage around the detector
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2.2.8. Timing

• Compute Pileup with this box checked, GADRAS will simulate pile-up effects from
random coincidences in high-count rate simulations

• Shape Time (vs) is an empirical parameter to describe the shaping time of the amplifier.
Since the amplifier shape time constant is generally only approximate, it is often necessary to
characterize this parameter from calibration spectra. If the detector has a pileup rejecter, as
most modern systems do, this field should be entered as a negative value, with a magnitude
approximately equal to the shape time constant in microseconds. The value should be
approximately -5 for typical HPGe detectors equipped with pileup rejection circuitry.

2.2.9. Shield / Collimator

These parameters describe shielding on the sides and back of the detector in addition to the
attenuators. This can also be used to add a collimator to the detector.

Shielding materials are specified by specifying Side parameters and Back parameters. The Side % is
defined as the percent of the side of the detector that is covered by the shield. This will be set to 100
if the shield completely covers the sides but does not extend past the front face of the detector. The
length of the shield is described as a percent of the detector length, so collimators can be described
by entering a value that is greater than 100%. For example, a value of 230 indicates that the length of
the shield measured from the back of the detector to the front of the shield is 230% of the detector
length (i.e., the shield extends 1.3 times the detector length in front of the detector). Similarly, Back
% is defmed as the percent of the back of the detector that is surrounded by the shield. For
collimators with an aperture less than the diameter of the active detector element, the Alt
Collimator Diam field allows specification of the aperture size. The AN and AD parameters
describe the material of the side and back shields.

2.2.10. Fluorescence X-rays

Some detectors are constructed with high-atomic-number materials in the vicinity of the active
volume which produce fluorescent x-rays in response to external radiation. This can also be used to
describe the magnitude of the x-rays from a shield or collimator.

GADRAS allows for two fluorescing Materials with respective Magnitudes. An approximate
energy dependence is applied for these x-rays

2.2.11. Coincidence / Imaging

In some detector systems, the primary detector is surrounded by another detector, called an
anticoincidence (AC) shield. This reduces background by rejecting events recorded simultaneously in
both detectors. AC shields reduce the Compton continuum by excluding interactions where a
photon scatters between the primary detector and the AC shield. The default setting is no AC shield.
The effects of AC shields can be treated by defining the parameters under the Anti-coincidence
shield section:

• Type: The type of AC shield detector material (e.g. NaI)

• Solid Angle (%): Solid angle percentage subtended by the AC shield from the primary
detector
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• Thickness (cm): Thickness in cm of the AC shield

• Dead Layer Z: Average atomic number (AN) of the dead layer on the AC shield
• Dead Layer AD: Areal density of the AC dead layer in g/cm2

• Shield LLD (keV): Lower-level discriminator of the AC shield

GADRAS can support gamma-ray imaging sensors including Compton cameras, and coded-
apertures with or without mask/anti-mask operation. For Compton cameras, the parameters are
described by:

• Spatial Coverage (%) is the average percentage of photons that do not escape the material
after scatter

• Correct pixel (%) is the percentage of Compton scatter events that are assigned to the
correct pixel

• Ang. Resolution (deg) is the angular resolution in degrees that the imaging system can
resolve an event to

For coded aperture systems, the parameters are the same for regular and mask/anti-mask systems.
They are described by:
• Focal Length (cm) is the focal length for the system — this is usually determined during

post-processing of the data

• Mask Width (cm) is the width of the coded aperture mask

• Ang. Resolution (deg) is the angular resolution in degrees that the imaging system can
resolve an event to

• Mask AN is the atomic number of the coded aperture mask

• Mask AD is the aerial density of the coded aperture mask

2.2.12. Environment

GADRAS allows for various scattering environments that a measurement may be taken in. The
following options are currently supported by GADRAS:

• On Ground is the most common Environment and assumes the detector is positioned
horizontally

• Aerial is the used for high altitude detectors (such as those mounted on helicopters or
airplanes); in this case, the Detector Distance is the distance between the source and the
detector, and the Height is the distance above the ground that the source is located

2.2.13. Photon Scatter

GADRAS includes a library of scattering kernels which are used to calculate scattering contributions
from any surfaces present in the environment surrounding the source and the detector. The source-
to-detector distance and height determine the position of the source in a nominal room. The
scattering magnitude is sensitive to height, so it is important that this parameter is accurate before
attempting to adjust the Photon Scatter parameters. The Clutter parameter determines the average
distance from the detector to the walls in the room. The following guidelines can be used when
determining initial scatter parameters:

• Outdoors/Large Room should have a small Clutter term (less than 3).
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• Average Room should have a Clutter term equal to 3 (indicates an average distance of 3
meters to the surrounding walls in the room).

• Small Room should have a Clutter term that is computed using the equation 900/ {average
distance to the walls in cm}.

The scatter parameters labeled 0 Degrees, 45 Degrees, 90 Degrees, 135 Degrees, and 180
Degrees adjust the magnitude of the scattered radiation. The 0 Degrees parameter corresponds to
low-angle scattering within the environment, which manifests itself as continuum just below the
photopeak energy. The 180 Degree parameter corresponds to a photon which has backscattered in
the environment and manifests itself in the backscatter peak. A value of 3 in these fields indicates
that the observed scattering continuum in the detector is consistent with the external environment.
Values may exceed 3 if additional scattering occurs within the detector housing. Setting the scatter
terms to zero disables the computation of scattered radiation.

• Rate @ E->Edge adds or subtracts continuum just below the Compton edge (less than 3
reduces, greater than 3 adds)

• Rate @ E->0 adds or subtracts continuum as the spectrum approaches zero energy (less
than 3 reduces, greater than 3 adds)

• Increase with E adds or subtracts additional scatter with increasing photon energy (less
than 3 reduces, greater than 3 adds)

• Attenuate further reduces low-energy continuum

2.2.13.1. Advanced Scatter

Some measurements can be taken in the presence of an object that produces preferential scatter
features that are observable in the spectra. To account for this, the Advanced Scatter parameters can
be adjusted. The parameters are described by:

• Pref Angle (deg) is the average preferential scatter angle in degrees

• Pref Angle +/- (deg) is the interval size for the preferential angle (e.g. preferential scatter
from 40-50 degrees would have a Pref Angle of 45 and Pref Angle +/- of 5)

• Pref Angle Mag is an empirical parameter that determines how much influence the
preferential scattering material has on the spectrum

2.2.13.2. Environment.dat

For special environments (e.g., source and detector are not at the same height, or placed in a corner),
a user can define an Environment.dat file in the detector directory. An example Environment.dat
file is located in "GADRAS \Detector\3x3 \NaI AboveSource".

NOTE: The Environment.dat file will override the Photon Scatter parameters and the
Distance and Height parameters.

27



2.2.14. Air Pressure

The air pressure defines the density of intervening air and is only significant when the source-
detector distance is greater than about ten meters. Air attenuation is determined by the atmospheric
pressure (Air Pressure) or the Elevation fields.

2.2.15. Neutron Scatter

Most gamma detectors are sensitive to neutron radiation. These parameters define the intensity of
neutrons on the gamma detector:

• Environment Drop-Down Box describes the reflection of neutrons in the surrounding
environment, also called the room return. Options are "No reflected neutrons", "Outside or
large bay", "Indoors above suspended floor", and "Indoors above concrete on groune. The
neutron reflection is dependent on the distance and height parameters as well.

• Thermal Stopped % is the percent of thermal neutrons that are stopped by exterior
shielding around the detector sensor (e.g. cadmium shield)

• Reflection Scalar directly scales the rate of neutrons reflected by the surrounding
environment uniformly across all energies

2.2.16. Computation Options

These control options aren't necessarily part of the detector response, but may differ between
detectors.
The Weight Range area has two fields: Lower Limit and Upper Limit. During any analysis or
fitting, GADRAS will attempt to fit only the region of the spectrum defined by these limits. Grayed-
out regions in the plot indicate ignored portions of the spectrum and are not used in any analysis or
fitting routine.

• Default # Channels: When generating synthetic spectra, this defines the number of
channels in the spectra.

• Template Error (%) defines the assumed error with the simulated spectrum. This is used in
the chi-square estimate.

• Assume MCA Bins from Inbin: this checkbox toggles the usage of the Inbin.dat file.
Inbin.dat defines relative channel widths and is useful for detectors with non-uniform
channel widths. This checkbox is only enabled if Inbin.dat is present in the current detector
directory.

• Collapse Spectra to Rebin: this checkbox toggles the use of the Rebin.dat file. Rebin.dat
contains a list of energy groups, usually less than the detector's total channel count, to reduce
computation time for certain analyses. This checkbox is only enabled if Rebin.dat is present
in the current detector directory (users can use Rebin tool to generate Rebin.dat).

2.2.17. Calibration Options

The default detector configuration with respect to the measured source is described by the following
parameters:

• Distance is the source-to-detector distance in cm measured from the center of the source
to the center of the detector face.
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• Height is distance in cm above the ground. For most applications the detector and source
are assumed to be at the same height.

• Replace Ecal in All Files: when the Default Energy Calibration parameters are varied in
a detector response characterization, this box allows GADRAS to overwrite the energy
calibration parameters in the files used with the default parameters.

2.3. Detector Tab Menu Items

2.3.1. File Menu

As seen at the top of Figure 3, the File menu allows users to save the current detector parameters or
to browse the detector directory. Clicking on Save Detector Changes or pressing Ctrl+S will save
the current detector parameters to the Detector.dat file. If changes are made and the user attempts
to navigate away from the Detector tab or attempts to close GADRAS without saving the
parameters, GADRAS will prompt the user to save the detector parameters. Users may click
Browse Detector Folder or press Ctrl+B (on any tab) to open a new Windows Explorer window
for the current detector directory. Users may click Recent Detectors or press Ctrl+R (on any tab)
to open a form listing recently used detectors. Users may select a detector from this form to quickly
change detectors.

2.3.2. Restore Points

Restore points allow users to save the current detector response parameters. If users are trying to
improve an existing detector response function but do not want to lose the original parameters, they
may create a Restore Point. This is done by selecting Create New under the Restore Points menu
item (Figure 6). If the detector parameters are adjusted incorrectly, they can be reverted to a set of
previous parameters by clicking the appropriate Restore Point.
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Figure 6. Restore Points Menu item

2.4. Detector Tab Calibrate Response

To optimize detector parameters click the Calibrate button at the bottom right of the detector page.
This adjusts the parameters that the user has selected to match measured calibration spectra to
computed spectra. To select a parameter for adjustment, users should click on the label of the
parameter. Parameters that are highlighted in orange have been chosen for adjustment.

Calibration spectra are added to the SpecPair tree on the detector page (Figure 7) by dragging and
dropping records from the PCF Viewer form (Section 0) into the tree. Users can add up to eight
SpecPairs to use in the calibration. Users should specify a Foreground and Background as well as a
Source for the computed spectrum. GADRAS will subtract the Background from the Foreground
(using count rates in each energy bin) and compare the measured spectrum to the computed
spectrum for the specified source. It will do this comparison for each SpecPair specified in the
Calibration form. GADRAS will then vary the adjustable parameters and find the best parameter fit
through non-linear regression iterations.
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Figure 7. Detector Response Function Calibration Spectra

To effectively calibrate a new detector to measured spectra, users should first determine the energy
calibration and peak resolution before varying other parameters. Users should not attempt to vary all
the parameters at once, as this may lead to degenerate solutions that do not reflect the best detector
response parameters for a given setup. Users should vary energy and resolution parameters first,
then attenuators and scattering parameters. Some parameters may be known prior to performing the
Response Function Calibration (such as Shape Time or Shield Attenuator properties). In this case,
users should input these parameters before attempting any detector response function calibrations.
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3. PCF FILES

3.1. PCF File Description

The main file format intrinsic to GADRAS is a binary, direct access file with a PCF extension.
GADRAS can read many other spectral file formats (including Ortec CHN, IAEA SPE, ASC, PCC,
N42, etc.) from many vendors and convert them to the GADRAS preferred PCF file format. PCF
Files contain energy calibration coefficients and other supplemental information.

GADRAS generates and stores PCF files in the same file location as the Detector.dat file. The
Detector.dat file must be defined prior to evaluating spectral data. Selection or creation of the
detector (Detector.dat file) is discussed in Section 2.1. A PCF file can be created from the Plot tab
on the main screen. To do this, the user can select New from the File drop-down menu, as shown
in Figure 8. After the PCF file is created, the PCF Viewer will display a blank PCF file as shown in
Figure 9.

GADRAS 1$.3.0 la.Nal MidScat

Detector

File Tools

Plot

Help

— I=1 X

Time History Analyze Model Neutron Inject Tools Setup

New PCF File... arl-F N

Open Spectrum File.,. Ctrl-FO
Foreground Background

Blank SpecPair

Add SpecPair Delete SpecPair

Computed Sources

Source Detector Distance HeightM

Add Source Delete Source

Plot

Figure 8. Creating a New PCF File From the Plot Tab Within the File Menu
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Figure 9. Newly Created PCF Shown in the PCF Viewer

Spectral files of almost any format can be added to the blank PCF by dragging and dropping the
desired data file to the gray area in the PCF Viewer. Figure 10 shows the file list form after
populating the PCF file with eight spectral entries (five calibration source spectra and three
background spectra).

GADRAS can process spectral data taken at different source-to-detector distances and
source/detector heights. The distances and heights can be specified in the Title field of the PCF
record. To specify the source-detector distance, the "@" sign must be used, followed by the
distance in cm or m. The detector height can likewise be specified with "H=". For example, a
spectrum taken at a height of 20 cm and a source-detector distance of 50 cm would have "@ 50 cm
H=20 cm" in the Title field.

[PCFViewer] cal.pcf - 0 X

file Edit Options Calibrate

Ecal: Aal - 4.41 3198.33 0.00 0.00 0.00

ldx Title Source Date & Time TL(s) TT(s) G(cps) N(cps)
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3 V-88 @ 122 cm, H=56 cm 88Y_495182 14-Nov-1995 12:27:24.19 535 537 549

IN Cs-137 122 cm, H=56 cm 137CS_495171 14-Nov-1995 12:37:32A9 585 587 3 554 Ili)■
5 Co-57 @ 122 cm, H=56 cm 57C0_495181 14-Nov-1995 12:49:16.96 680 684 616

6 Am-241 @ 122 cm, H=56 cm 241AM_495192 14-Nov-1995 13:0047.60 648 650 494 111

7 Backqround 14-Nov-1995 13:09:09.89 479 481 450 0

8 Backqround 14-Nov-1995 12:0420.07 553 Sigamirir_

Deviation pairs in file Channels: 512 Num Records: 8

Figure 10. PCF Viewer with Spectrum Records Added

3.2. Editing PCF Files

The PCF Viewer edits the contents of a PCF file. Each entry or row in the PCF Viewer is a
spectrum (record) stored in the PCF file. Editing cells in this table immediately edits and saves the
contents of the PCF file. Editable fields include Tag, Title, Source, Date & Time, TL (live time),

34



TT (total time), N (neutron count rate), Offset, Gain, Order 2, Order 3, and LowE. Not all fields
are visible by default. Users can modify which columns are visible using the Select Columns to
Display under the Options menu.

The top of the PCF Viewer form contains shortcuts and fields with various functionality. From left
to right they are:

• Create a new PCF file

• Open a spectrum file

• Print record header information
CI)

• El Choose which columns are visible

• Display spectrum preview thumbnail

• PR Peak search energy calibration

• Ecal: This displays the energy calibration for all records in the top menu bar, if the energy
calibration is the same for each detector (by default there is only one detector). If the energy
calibration for one record changes, this editor will disappear.

• Display/hide energy calibration columns

If a PCF file contains records with different energy calibration parameters, the following icon is
displayed instead of the Ecal labels:

• 9tii Overwrite all records' energy calibrations with current record's energy calibration

3.3. PCF Viewer Menu Items

3.3.1. File Menu

Under the File menu, users can create new PCF files or open existing PCF files; Import File will
append existing files to the current PCF file (similar to drag-drop); the Print command sends the
contents of the PCF Viewer window to a printer; Export to CSV... will export the PCF file record
headers to a CSV file.

3.3.2. Edit Menu

Each record in the file has its own energy calibration parameters. The Energy Calibration for All
Records (Figure 11) option allows users to modify all records simultaneously.
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Figure 11. Edit Energy Calibration for All Records Editor
The Deviation Pairs menu option brings up the Deviation Pair Editor form, which is discussed in
Section 6.3.
Reformat All Titles allows users to normalize their title formats for large files quickly. It searches
for Distance, Height, and Detector Name information and reformats them to a standard.
Update with .lis file imports a file formatted in the .LIS format (normally exported header
information from a PCF into the GADRAS Temp folder), and overwrites the current file's header
information with information from the .LIS file.
If users inadvertently change a field in the PCF file, they can choose Restore to Last Backup in the
PCF Viewer's Edit menu.

3.3.3. Options Menu

Users can modify which columns are visible using the Select Columns to Display under the
Options menu. The Options menu also has an option to toggle the spectrum preview window on
the right side of the PCF Viewer.

3.3.4. Calibrate Menu

3.3.4.1. Peak Search Calibration All Records

Figure 12 shows the Peak Search and Manual Energy Calibration form. Users can drag-drop a
record (row) from the PCF table into the blank portion of the Peak Search window. Users can drag
right over regions of interest to zoom in. To zoom out, drag left. Clicking a peak in the spectrum
will include the peak in the fitting routine. Peaks recognizable by GADRAS for this procedure are
shown in red above a green continuum with the default 5 sigma peak threshold, as shown in Figure 12
(light).
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Figure 12. The Peak Search and Manual Calibration Screen is Blank When First Opened (left) and
Populated When a Spectrum is Loaded (right)

The Peak Threshold (sigmas) option can either be lowered to recognize additional peaks or raised
to recognize fewer peaks. Clicking a peak will open a window prompting the user to specify the
energy of the peak as shown in Figure 13. If the centroid energy is close to a known peak for an
isotope included in the GADRAS library, the isotope will be displayed along with the determined
gamma-ray energy. Other peaks and energies around the determined value are also listed. The initial
peak energies are based on the detector's current energy calibration parameters. Users may select the
appropriate isotope and energy in the provided list, or they may manually enter the appropriate
energy for the isotope. Clicking OK assigns the Actual Energy selected to the channel number in the
spectrum. This process can be repeated for any number of available peaks in the measured spectrum
as needed to complete the channel/energy table (although selected peaks should be spaced more
than 200 keV apart).

virj Change Energy

pparent Energy (keV):

4,ctual Energy (keV):

0 X

661.24

661.66

A658.40 At207 6300 %yield

658.86 Pu239 0.000 % yield

659.10 Sr83 0.544 %yield

659.75 Th229 0.036 % yield

66136 TI203 2271 %yield

661.66 Cs137 85.126 %yield

66224 U239 0.182 %yield

662.40 Arn241 0.000 %yield

Cancel

Figure 13. Users Can Select the Energy of the Peak From the Popup Window, or Manually Enter
the Known Energy
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After entering an appropriate number of peaks in the channel/energy table, energy calibration
adjustments can be performed. The upper-left portion of Figure 14 displays the two energy peaks
that were selected for energy calibration (channel/energy table) and the upper-right portion displays
the Adjust Parameters tab. The highlighted (orange) parameters will be adjusted. After the peak
selection process is complete and the appropriate parameters are adjusted, clicking the Fit
Parameters button below the parameter group boxes will initiate the least-squares fit to the data.
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Figure 14. Energy Calibration Screen Showing the Selected Peaks and the Highlighted (cyan)
Parameters that will be Adjusted (center)

To ensure a proper energy calibration, a small subset of well-known peaks should be selected.
GADRAS will then properly assign energies for subsequent peak selection.

It is usually advisable to use Order 0 and Order 1 for an initial energy calibration, and then to
include higher orders if the fits are not acceptable. The Order 1 energy parameter should be
approximately equal to the full scale energy value of spectrum in keV (e.g., 1500, 3000, 11000)
depending on the detector. In general, small values are common for Order 0, 2, and 3 energy
parameters. Once the energy offset and gain (Order 0 and Order 1) parameters are adjusted
correcdy, the energy resolution parameters should be adjusted.
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3.3.4.2. Linearize All Records

This option uses the energy calibration from each record, along with any deviation pairs defined, to
determine the energy bounds for each record. It then rebins all records into a linear channel-group
structure, such that the calibration is defined only with a gain term (zero offset). The deviation pairs
in the file are erased.

3.3.4.3. Calibrate and Linearize All Records

This option, in addition to the linearize option, attempts to automatically calibrate each spectrum.
This can be done for each record based on the 2614 keV peak, 1460 keV peak, or based on each
records' Tag character. The following Tag characters are acceptable in this context:

• T only adjust gain based on 2614 keV peak

• t adjust gain and offset based on 2614 keV peak and 239 keV peak (use 583 keV peak
if available)

• K only adjust gain based on 1460 keV peak

3.3.4.4. Automatic Energy Calibration Tool

This tool searches the entire spectrum for common background peaks, and fits the energy
calibration parameters, resolution parameters, and skew parameters automatically. It gives users the
option to write the fitted parameters to all records in the file, or just the one that was used to search
for background peaks.
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4. PLOTTING/VIEWING SPECTRA

4.1. Measured Spectra

Users can plot one or more gamma-ray spectra from the Plot tab (Figure 15).

A record from a PCF file can be plotted by dragging and dropping an entry from the PCF Viewer
to the Measurements table. The Measurements table consists of four columns. The first column
is the plot style for the measurement. The second column is the title of the foreground spectrum.
The third column is the foreground spectrum file name and record. The fourth column specifies the
background. Users can manually specify foregrounds or backgrounds by double-clicking the cell and
typing into the table. The cell will suggest autocomplete values for the foreground or background
using all the known spectral files in the current detector folder. The background will be time-
normalized to the foreground. Clicking the Plot button will display the desired background-
subtracted spectra. Figure 16 shows a plot of a background-subtracted 228Th measurement.

11 GADRAS 13.3.0 101Na I MidScat — lil X

Detector Plot Time History AnaIre Model Neutron Inject Tools Setup

File Tools Help

Measurements

Title Foreground Background

Th-228 CI 122 cm, H= 56 cm catpirL2 cal.pcf,1

Add SpecPair Delete SpecPair

Computed Sources

Source Detector Distance Height

Add Source Delete Source

Plot

Figure 15. Plot Tab with Entries to be Plotted From the "Cal.per File

The Add SpecPair and Delete SpecPair buttons in the middle of the screen are used to add or
remove measured spectra from the drawn plot. When the Add SpecPair button is clicked,
GADRAS adds the subsequent record from the current PCF file to the Foreground spectrum. The
previous Background record is maintained by default. If the previous Foreground record was the
last record in the PCF file, the same foreground is added to the table again. The plot style can be
changed for a measurement by clicking on the plot style cell in the measurement table.
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Figure 16. Plot of Background Subtracted 228Th Spectrum

Figure 17 shows a plot with three spectral pairs selected for graphing. These pairs are displayed in
the central white area of the Plot tab. Up to six spectra can be selected and displayed in a single
graph.
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Figure 17. Plot Tab Example with Three Background-Subtracted Spectral Pairs

Figure 18 shows the graph of the three spectral pairs identified in Figure 17. The graphs are
identified for each spectrum by the color selected in each style cell in the Measurements table.
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Figure 18. Plot of the Three Background-Subtracted Spectral Pairs: 228Th (black), and 88Y (blue),
and 137Cs (cyan).

Figure 19 shows the Plot Style selection form. From here, the color, symbol, and line style for a
measurement or computed spectrum can be specified. Common presets for HPGe and Nal

spectra can also be selected.

1:171, Styl e X

Color:

Symbol:

Line:

Error Bars

None

HPGe Preset

Nal Preset

Y-Pais Scale: 6 Log Cycles

Y-Pais Scale: Square Root

Cancel DK

Figure 19. Plot Style Selection Window

4.2. Plotted Spectrum Window

After the plot is displayed, navigation can be done with the mouse. Drag from left to right to zoom
in on a region of interest as shown in Figure 20. Dragging from right to left a small amount will
partially zoom out. Dragging from the right to left a large amount will completely zoom out.
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Scrolling the mouse wheel will change the number of log cycles displayed or switch between square
root, linear, and logarithmic scales.
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Figure 20. Zooming-in on a Plotted Spectrum

The top of the plot window shown in Figure 20 contains shortcut buttons and additional options.
Starting from left-to-right, they are:

• e Save the computed spectrum to file

• Reset the zoom (zoom out completely)

• AA+ Enable/disable peak search mode
• SE Show the single-escape line (see Figure 21)

• DE Show the double-escape line (see Figure 21)

• C Show the location of the Compton edge (see Figure 21)

• E-Min / E-Max: These are default limits of the plot in keV.

• Channel Number or Energy (keV): This drop-down box allows users to view both
channel number and energy, or just energy units on the x-axis

• Counts/keV or Counts/Channel: This drop-down box changes the normalization factor
for the channel bins (normalize by energy, or normalize by channel).

• Log Cycles or Square Root or Linear: This drop-down changes the scale of the y-axis.
This scale can also be modified with the mouse-wheel.

• Toggle between showing positives only or showing both positive and negative values
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On the left-hand side of the plot window is a collapsible panel containing additional plot options.
From top-to-bottom, they are:

• Energy Calibration: These options modify the behavior of graphical energy calibration (see
Section 6.2 for more detail on graphical energy calibration). The drop-down box specifies
which spectra are to be modified (each record has its own coefficients). By default, all
records from all files plotted are modified. Users can choose to only modify all the spectra
that are plotted, or an individual spectrum plotted. The ability to modify the energy
calibration of a single spectrum from a file is useful if there is gain or offset drift between
measurements.

Under the drop-down box there are two radio buttons to select whether the energy
calibration coefficients for the foreground and subtracted background are to be modified
(default), or just the foreground.

• Display Options: The first drop-down box has three choices to display how spectra are
plotted. This only has an effect on line-style plotted spectra, not on "error-bar" style plotted
spectra. The options are Curve (Default), Histogram, and Bar Chart.

The second drop-down box controls the grid on the chart. By default, only the x-axis and y-
axis at zero are plotted (Zero Crossings). Users can turn off all grid lines (No Grid), or
shown them throughout the chart (Dotted Grid).

• Misc: The first drop-down box contains smoothing options. The default is to display at
most 1024 channels. However, if a user zooms in to a region that has less than 1024
channels, no rebinning is done and all channels are displayed. Other options include 512
channels, Smooth Magic, Smooth by FWHM, No Smoothing (display all channels), and a
variety of smoothing options by percent of energy. These only affect how the spectrum is
viewed, not any analysis or computations.

The default true-time is only used when only a computed source or calibration source is
plotted without a foreground (from which the true-time is extracted).

4.2.1. File Menu

The File menu consists of the following options:

• Copy to Clipboard copies the plot screen to the clipboard as an image and can be pasted
into another application

• Write Computed Spectrum to File saves the computed spectrum to a pcf file for future
plotting

• Save to Metafile saves the plot screen to an image file (.emf)

• Save to Sum Spectrum saves Time History sum graph to separate file

• Save Flux File saves flux file for Compute Flux analysis on Time History spectrum

• Print: allows users to print the displayed graph

• Export Plotted Spectra to CSV: allows users to export all spectra to CSV format
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4.2.2. Tools Menu

The Tools menu provides options for graph properties, peak lists, and count rates:

• Zoom to Extents: zoom the graph out to the full energy limits

• Count Rates: provides the count rate for each of the graphed spectra at the currently
displayed energy limits

• Peak Search Mode: provides energy and count rates for peaks in the spectrum in graphical
and list form

• Edit Deviation Pairs: allows the user to view and edit the deviation pairs associated with
the current spectrum

• Show Peak List: displays a list of peaks that can be overlaid on the spectrum; by selecting
an entry, all peaks from the specified source and threshold will be displayed (this option is
discussed in more detail in Section 6.1.1).

• Show Isotope DB: displays the Isotope Database for use in analyzing displayed spectra
(discussed in Section 6.1.2)

4.2.3. View Menu

The View menu allows users to display common features of a plot using the cursor. When users
select any of Single Escape, Double Escape, or Compton Edge, the cursor location on the spectrum
is used as a starting point and energies of the specific features are calculated and displayed on the
screen (Figure 21).
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4.3. Computed Sources

Besides displaying measured spectra, GADRAS can also display computed spectra. Sources for
computed spectra are entered in the Computed Sources table on the bottom of the Plot tab. Some
measurements have computed sources already associated with them. If a foreground is added to the
Measurements table, the associated computed source will be added to the Computed Sources
table. Users add computed sources by clicking the Add Source button at the bottom of the
Computed Sources table. There are numerous ways to specify the source, most of which are
accessible by right-clicking the source cell (see Figure 22).

GADRAS 1$.3.0 3x3\Nal MidScat

Detector Plot

File Tools Help

Measurements

1=1 X

Time History Analyze Model Neutron Inject Tools Setup

Trtl e

.1. Th-228 .13 122 cm, H=S6 cm

Foreground Background

cal.pc1,2 cal.per,1

Add SpecPair Delete SpecPair

Computed Sources

.
Source Detector

Save to Foreground

Source Wizard..,

Browse Detector Folder.,.

Browse Source Folder..,

Choose Detector For Source..,

Distance Height

56

Add Source Delete Source save Sources

Residuals

E

Figure 22. Right-click menu to show computed source options

Plot

4.3.1. Source Wizard

The Source Wizard option shown in Figure 22 allows users to add sources quickly and view all
options for the source. The Source Wizard form is shown in Figure 23.
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Figure 23. Source Wizard Screen

The drop-down menu in the source wizard allows users to select various types of sources, such as
radionuclides and distributed GAM files. Users can use the arrows in the center of the window to
add or remove sources from the current list of Included Sources. The third column on the far right
of the Source Wizard allows users to edit the source activity, the GADRAS shorthand notation for
shielding, or to apply 3D Effects. After clicking OK, the Source Wizard will automatically generate
the GADRAS shorthand string in the Computed Spectrum text box.

4.3.2. Browse Folder for Source

Users may browse the current Detector folder or a subfolder of the GADRAS Source folder for
computed sources. Figure 22 shows options for Browse Detector Folder and Browse Source
Folder. These options will allow users to browse the selected folder for a source to plot. Users can
modify the source line manually or use the Source Wizard to specify more options for the source, or
to add more sources.

4.3.3. Other Computed Source Options

Users have the option of saving a computed source to a given measurement. Users can right-click a
source and hover over the Save to Foreground option to list the measurements that the source can
be saved to, as shown in Figure 24.
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Figure 24. Users can save a computed source to a measurement

By default, the current gamma detector will be used when computed the detector response for the
specified source. Users may change the detector to be used for the response if desired. This is done
by selecting the Choose Detector For Source... option and navigating to the desired Detector.dat
file. Alternatively, users can double-click on the detector cell and navigate to the desired
Detector.dat file. The Distance and Height fields can be updated for the computed sources by
typing in the cell.

4.3.4. Simulated or Calibration Source

In lieu of using the source wizard option, the user can enter source information manually in the
computed source cell. To do this, highlight the cell and begin typing.

Sources may include:

• The name/serial number of a calibration source in the source library/database
• Distributed GAM files

• Isotopic designation and source strength (e.g., 232U, 1.5uC)

• 3DM files (for 3D scenarios)

• A single-energy source (e.g. 200 keV)
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• An x-ray from an element (e.g. AgXray)

Activity units for the computed spectrum are always given in Curies (shortened to "C" instead of the
standard "Ci"). This unit may be prepended with the following SI prefixes (not case-sensitive):

• pC: picoCuries

• nC: nanoCuries

• uC: microCuries

• mC: milliCuries

• kC: kiloCuries

Alternatively, Becquerel units can be input using the following SI prefixes (also not case sensitive):

• kBq: kiloBecquerel

• MBq: megaBecquerel

• GBq: gigaBecquerel

Mass or activity of a source can be specified and used for plotting. The mass is converted to the
proper activity prior to plotting (e.g., 239Pu, 50g is converted to 239Pu, 3.1C).

When GAM files are used, a scaling factor for the source can be applied by appending a number
after a comma. For example, "example.gam,2" indicates that the source strength of example.gam
should be doubled in the computed spectrum.

The simulated/computed spectrum can be a mixture or sum of several sources. The individual
sources can be summed by placing a plus (+) sign between the successive sources (e.g., 232U,
luC+40K, 25mC). Gamma-rays emitted by the specified isotopes are folded through the detector
response function to compute the spectrum that would be recorded if the detector were exposed to
the combination of the specified sources. If a single measurement/computed source pair is plotted,
the reduced x2 metric for the measured and computed spectra is calculated and displayed.

4.3.5. Viewing Spectra

Figure 25 shows the Plot tab with a 88Y spectrum (cal.pcf, 3) in the foreground cell and a
background spectrum (cal.pcf, 1) in the background cell. The Computed Sources table shows that
the measured spectrum is to be compared with the computed spectrum for the 88Y source with serial
number 495182 entered as 88Y_495182.
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Figure 25. The Plot Tab Displaying Selections for a Foreground, Background, and Computed
Spectrum

Figure 26 is generated after the Plot button is clicked. The measured 88Y spectrum (background
subtracted) is displayed in black, while the computed spectrum for the 88Y source (ID number:
495182) from the source library is displayed in red. The count rate is displayed at the bottom left of
the graph for all graphed spectra for the displayed energy region. The count rates are color coded to
match the color of the corresponding spectrum.
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Figure 26. Plot of a Measured 88Y Spectrum (background subtracted) and the Computed Spectrum
from 88Y Calibration Source

Computed sources may be plotted by themselves by deleting all the measurements in the
Measurements table. If desired, effects of shielding materials can be estimated by specifying the
material in the source cell. The atomic number and areal density of the absorbing material can also
be entered on the input line using the following convention:

232U,10uCi {AN=26, AD=10} + 137Cs,3.2mCi {AN=13, AD=5}

In this example, 10uCi of 232U is propagated through 10 g/cm2 of iron (Z=26), and 3.2mCi of 137Cs
is propagated through 5 g/cm2 of aluminum (Z=13). This functionality is also accessible from the
Source Wizard form, described in Section 4.3.1.
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5. COUPLING GADRAS TO EXTERNAL RADIATION TRANSPORT
CODES

To accurately model very complex sources or sources in complex scattering environments using
GADRAS, an external code should be used to perform the radiation transport calculations.
Radiation transport codes such as the Monte Carlo N-Particle (MCNP) code, developed by Los
Alamos National Laboratory, can be used to model sources and scattering environments. This
section describes how users should set up external radiation transport codes (specifically MCNP but
the same procedure can be generalized for use with other codes) to use with GADRAS.

GADRAS calculates the detector response for radiation directly incident on the detector as well as
for radiation that has scattered in the environment before interacting with the detector. To calculate
the scattered radiation, GADRAS has several scatter parameters which simulate a general scattering
environment. External transport codes can be used to calculate the incident radiation instead of
GADRAS. To do this, the external code should be used to model the radiation current separately on
multiple facets of the detector. Using the results, GADRAS can compute gamma-ray spectra and
neutron count rates for a given scenario. These results may have a higher degree of fidelity than can
be obtained by applying the GADRAS's radiation transport methods. If a source cannot be
approximated with a point source, an external code can be used to calculate the radiation transport
from the source to the detector with a higher degree of fidelity than GADRAS alone.

The setup for the scenario should be designed to simulate the external scattering environment and
tally the energy-dependent current on each surface of the modeled detector. The output files should
then be converted into files that are compatible with GADRAS. These input files are called "multi-
faceted GAM files." GADRAS processes these multi-faceted GAM files by calculating the detector
response from the radiation that scatters within the detector housing, assuming that the external
transport code has accounted for the external radiation scattering.

To correctly process multi-faceted data generated by other codes, users need to suppress
GADRAS's external scatter radiation calculations by setting all of the scatter parameters to zero
(Figure 27). The radiation transport code must tally photons and neutrons that scatter into the
detector from the floor, walls, ceiling and any other object in the detector's vicinity; GADRAS will
account for radiation scatter within the detector.
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Figure 27. Set aIl Scatter Parameters to 0 When Using Multi-faceted GAM Files

5.1. MCNP Methodology

To compute the detector surface currents for a given scenario, the MCNP model should contain a
cylindrical volume representing the detector. The cylinder should be positioned at the detector
location with dimensions similar to those of the detector. The current tally (F1) should be used to
tally the photons and neutrons that cross each individual surface (front, back, sides). The pulse-
height tally (F8) is not appropriate for use with GADRAS, as this tally represents the detector
response function generated by MCNP and cannot be readily converted to a format that is usable by
GADRAS. The current tally should be generated with the energy bin structure provided with the
GADRAS distribution in the "MCNP-photon-tally-bins.dat" file (usually in
C: \ GADRAS \Program \ Documentation \ CouplingExternalTransportCodes). Figure 28 below
shows a simple example of a 127Cs source 1 meter away in air. A photon importance of zero in the
detector cell ensures that the tally does not double-count particles that pass through the detector
volume.
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Simple Example Input Deck
1 0-1 imp:p=0 $ detector volume
2 1 -0.0012 -2 1 imp:p=1 $ surrounding air
3 0 2 imp:p=0

1 rcc 100 0 0 10 0 0 10 $ detector surfaces
2 so 1000 $ universe sphere

mode p
sdef par=p pos=0 0 0 erg=0.6617
ml 7014 -75 $ air

8016 -25
fl:p 1.1 $ side of cylinder, side of detector
fll:p 1.2 $ bottom of cylinder, front face of detector
f21:p 1.3 $ top of cylinder, back face of detector
e0 {insert values from MCNPbins.dat}

Figure 28. A Simple MCNP input Deck

The MCNP output file needs to be converted into a format usable by GADRAS. The tally from
MCNP should be converted into surface current density (particles/m2s) for each energy bin. To do
this, the source activity, particles per decay, and detector facet surface areas must be known. Figure
29 below shows an example of the necessary unit conversion for a 1 uCi 137Cs source counted with a
cylindrical detector (r=10cm, 1=10cm). Once converted to the appropriate units (particles/m2s), the
current densities can be incorporated into the GADRAS multi-faceted GAM file.

{front current density} = r front current
(source particle.)

side current
{side current density} =  

source partic2e)

f back current density} —
source particle

baciccurrent

(1 x10-6 Co(3.7x10102)(1
.40 cm)2( m )2

loo cm
(1 x10-6 ci)(3.7x10102)(1g

270.0 cm)(10 crn)( I m 2)
100cm

(1. x10-6 Ci)(3.7 x 101011(1 
Sq 
1=1s)

Cr 

n-(10 cm)2 ( 
im
 2)

100 01,1

Figure 29. Pseudo-code for Scaling MCNP Surface Current Outputs to Units Suitable for use with
GADRAS

Figure 30 below shows an example of a multi-faceted GAM file with current densities for the three
facets of a detector. GADRAS represents detectors as if they are symmetric normal to the detector
axis, so there is no distinction between the top, bottom, left, and right sides. The average current
over all the lateral sides of the detector should be specified as the third parameter on each line.
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Format specification (5
signifies multi-faceted
current data)

0 discrete photons
(always);
1,475 photon groups; 78
neutrons groups

m=
0 5 1 144-wr r , ode1Geometry

PhotonLines, PhotonGroups, NeutronGroups0 1475 78 .
2.000E+02 3.952E+04 4.155E+01 1.063E+02 ! photon groups
2.935E+02 1.222E+01 2.1313E+00 7.240E-01
2.957E+02 2.742E-01 1.290E-01 2.181E-01 Last photon grour

1.179E+04 0.000E+0C 0.000E+00 0.000E+00
1.200E+04 0.000E+0C 0.000E+00 0.000E+00 4e*.‘-'''''
1.965E+07 0.000E+0C 7.031E-03 3.073E+00 %\•ieutron groups
1.733E+07 3.016E-01 4.618E+00 2.070E+01

5.000E-03 9.419E+0C 2.706E-06 0.000E+00
First neutron group...1i

2.000E-03 4.727E-02 9.549E-08 0.000E+00
5.000E-04 1.149E-02 0.000E+00 9.003E+03
1.000E-05 4.277E+04 0.000E+00 0.000E+00

& w le.

Energy (keV-
photons, eV-
neutrons) at
lower (photon)
or upper
(neutron)
bound of
energy group

Current density

(particles/s/m2)
incident on front
surface

Avg. current
density incident
on side surfaces

Current density
incident on back
surface

Figure 30. Multi-faceted GAM File Example

In Figure 30 above there are NG + 1 lines for the photon groups and NN + 1 lines for the neutron
groups where NG and NN are the number of photon and neutron groups respectively. For multi-
faceted GAM files, there are always 0 discrete photons specified. The leakage values are specified in
units of inbound current density (particles/m2s, current divided by surface area) on each detector
surface. GADRAS accounts for the surface area of each detector facet when the response function
is computed for a given detector. As a result, the same GAM file may be used to compute a
response function for a different detector if it is situated at the same height and distance to a
radiation source.

The multi-faceted GAM file should be saved as <filename>.GAM, where <filename> is the user's
chosen file name. This file can then be included on the computed source line for plotting.

5.2. Automatic Conversion from MCNP Output to GADRAS Input

GADRAS is distributed with python scripts that will convert MCNP output files into GADRAS
input files. These scripts are located in the external transport codes documentation folder (usually
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C: \ GADRAS \Program \ Documentation \ CouplingExternalTransportCodes), and are called
"mfgf.py" and "mcnpfunc.py". Users can view and modify "mcnp_example.py" to use these scripts
properly. Currently only photons are included in the mcnp_example.py file.

To use these scripts, the MCNP model must be configured to create a MCTAL file as part of its
output. To do this, the line "PRDMP J J -1" must be included in the data card of the MCNP file.
The python scripts need several inputs to properly generate a multi-faceted GAM file for use with
GADRAS. Users must supply:

• MCNP MCTAL file

• Source activity (in Bq)

• Source yield (particles per decay)
• Area of face of detector in MCNP model (in m2)

• Area of side of detector in MCNP model (in m2)

Users must also install python on their computer and make sure the numpy library is present. To run
the script, users should type "python mcnp_example.py" into the command prompt.
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6. SPECTRUM ENERGY CALIBRATION

There are a variety of methods in GADRAS for energy-calibration. Section 3.3.4 covers how to
calibrate from the PCF Viewer by automatic methods as well as peak-search methods. The most
common method to quickly calibrate a spectrum is through the Plot window.

6.1. Helpful Tools for Energy Calibration and Peak Analysis

6.1 .1. Photopeak List

To aid in performing an energy calibration or in determining a peak's energy in a spectrum, the
PhotoPeak List library can be used. This list can be accessed:

• From the Tools tab on the main GADRAS window

• Using the mouse (shift+left mouse click (holding down the shift key while clicking the left mouse
button)) on a peak of interest in a displayed spectrum

• From the graph display form under the Tools menu, Show Peak List

• Pressing Ctrl+L on graph display form

The PhotoPeak List library is shown in Figure 31. The blue highlighted entry corresponds to the
gamma-ray automatically selected by GADRAS based on its proximity to the selected energy
location on the current plot (shift-left dick location). The selection also takes into account the relative
importance of the gamma-ray to the observable spectral features.
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y List of Photopeaks D X

Min. Relative importance 0.01

0 Overlay Fit Fit Thickness: 12 13El
Eil Overlay Lines Max Lines to Plot 7 : Fit Colon Cyan ,

.W.rgy (keVj Radionuclide Yield MI ^

1809 U238 0.0037

1310.7 Mn56 27.159

1831.4 U238 0.017

1836 Kr88 25.293

1836.1 Y88 99.24

13473 Y92 036

1347.4 Ra226 4.05

1347.4 131214 4.05

1847.4 Rn227 0.669
v

Nuclide: Y83

Half-life: 106.626 d

Age: 0.0 s

Specific Activity: 13.92 IcCi/g

Gamma and X-ray Radiation:

Energy A

(keV) 
Yield t'N Importance  Source

1836.1 99.24 0.5982 y8o,-› Sr33

393.04 93.633 0,3949 y88-›Sr88

2734.0 0.7145 5.26E-03 yaB-› Sr88 
Y

Other Radiation Ernitted:

Particle 1 Energy {ken I Yield {%} I Source

positron 764.515 0.210 Y38-> Sr83

Figure 31. PhotoPeak List Library with 88Y Highlighted and Both Overlay Options Boxes Checked

At the top left of the PhotoPeak List library screen are two check boxes for overlay options. The
overlay fit check box when selected will generate a spectral overlay fit for the selected isotope (a
single regression fit using one isotope). The spectral overlay displays the source activity and shielding
configuration estimated to provide the best fit to the measured spectrum. The overlay lines check
box overlays vertical lines at the appropriate energy locations for the selected isotope on the
measured spectrum utilizing the Max Lines to Plot selection. The displayed overlay can be changed
to display another isotope simply by selecting and highlighting another gamma-ray line in the
PhotoPeak List, allowing for rapid examination of many isotopes in the library. The color and line
thickness of the overlaid spectrum can be changed using the options at the top of the library
window. The selections displayed in the PhotoPeak List in Figure 31 are shown in the displayed
graph in Figure 32.
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Figure 32. Graph Displays the Measured 88Y Spectrum (black) with Both Overlay Options

The graph in Figure 32 displays the measured 88Y spectrum (black) along with both overlay options.
The overlay fit option generates a spectrum which is cyan and has a thickness value of two. The
overlay lines option displays the lines and their energies.

6.1.2. Isotope List

Another useful tool when graphically calibrating is the Isotope Database tool (shown in Figure 33).
The drop-down menu at the top of the form allows users to choose a radionuclide from the list.
This can also be used as a reference for emitted radiation from common radionuclides.

The graph in the center of the form shows the locations of the main photopeaks for the selected
isotope. The center of the window displays properties for the selected isotope such as isotope
designation, half-life, age, and specific activity. It also specifies if the nuclide is assumed to be in
prompt or secular equilibrium with its daughters. The bottom of the window displays characteristic
gamma-ray energies sorted by intensity multiplied by the square-root of the energy.

Users can display overlays of the nuclide on the current plot using the two Overlay checkboxes
located at the top of the Isotope Database form. The first checkbox overlays a graphical fit of the
selected isotope by automatically calculating the activity and shielding to best match the measured
spectrum. The overlaid spectrum is generated using the detector response function parameters
found in the Detector.dat file. The user may also change the color and line thickness of the overlaid
fit. The second checkbox overlays vertical lines on the plotted spectrum, which correspond to the
major energy lines of the selected isotope. The number of lines to display can be changed by the
user.
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GADRAS lists gamma-ray emissions from daughter radionuclides in the gamma-ray emission list for
a given parent. This occurs if the daughter radionuclide is usually observed to be in equilibrium with
the parent. For example, gamma-ray emissions arising from the decay of 208T1 are also listed under
232Th. The origin of a gamma-ray can be observed in the Source column of the table.

y Isotope Database X

33Y

0 Overlay Fit
Fit Thickness: 2 A

2 Overlay Lines Max Lines to Plot 7 Fit Color: 11±ed

Nuclide:

Half-life:

Age:

Specific Activity:

Y38
106.626 d

0.0 s

13.92 kci/g

Gamma and X-ray Radiation:

Energy (keW Yield pf.) importance Source

1$36.1 99.24 0.598 Y88-> Sr88

898.04 93.683 03948 Y88-> Sr8B

2734.0 0.7145 5.25E-03 Y88-> Sr88

5151999 0.420 1.52E-03 (annih.)

850.6 6.55E-02 2.69E-04 Y88-> 5r88
v

Other Radiation Emitted:

Particle

positron

Energy NeV) Yield DO I Source

754.515 0.210 Y88-> 5r83

Close

Figure 33. Isotope Database Form

6.2. Graphical Energy Calibration

Graphical calibration is an alternative method to using the Peak Search and Manual Energy
Calibration process (see Section 3.3.4.1). Graphical calibration can be used for the adjustment of the
gain and offset (Order 0 and Order 1) of the spectrum. This method uses a graph of the measured
spectrum and an overlaid spectrum from the PhotoPeak list or Isotope Database library (or a
specified computed source). Figure 34 (top) shows a measured 137Cs spectrum (black) and a library
137Cs spectrum (re4 This plot is zoomed in to the region around the primary 137Cs peak at 662 keV.
The measured spectrum (black) does match the computed spectrum (red). This implies that an energy
calibration of the measurement is needed.
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To calibrate the measured spectrum correcdy, the measured peak (black) should be adjusted to
match the computed spectrum (red). To make this adjustment, users can right-click-drag the peak in
the measured spectrum to the correct energy (the centroid of the peak in the computed spectrum).
After right-clicking the plot window will be outlined in red as shown in Figure 34 to indicate energy
calibration mode. Figure 34 (bottom) shows what the plot looks like after dragging the measured
spectrum to the left (while still holding down the right-mouse-button).

Release the right-mouse-button to complete the action (or press escape to cancel it). Once this
action has been performed, the energy calibration window shown in Figure 35 will appear for the
selection of the appropriate calibration parameter (offset or gain). The user will need to confirm the
adjustment before the energy calibration parameter will be changed.
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Figure 34. Graphical Energy Calibration Example
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Figure 35. Graphical Energy Calibration Confirmation Window

Due to the potential for inadvertent changes to calibration parameters, GADRAS requests
confirmation for the parameters to be adjusted when graphical calibration is used. If a gain
adjustment is made within thirty seconds of an offset adjustment, GADRAS will use both changes
simultaneously to fit the gain and offset. The quadratic option is only available once the following
criteria have been met:

1. Successful gain adjustment within 30 seconds

2. Successful offset adjustment within 30 seconds

3. The third adjustment energy is greater than 400 keV

4. The adjustment energy is greater than 0.4 times the full-energy-range away from the energy
used to adjust the offset

5. The adjustment energy is greater than 0.4 times the full-energy-range away from the energy
used to adjust the gain

For example, if calibrating a background spectrum and the 239 keV peak (Th chain), 1460 keV peak
(K-40), and 2614 keV peak (Th chain) are visible, users can drag the measured spectrum at 239 keV
to adjust the offset, the 2614 keV to adjust the gain, and then the 1460 keV to adjust the quadratic
term. However, if the user tries to use the 583 keV peak (Th chain), GADRAS will not allow a
quadratic adjustment because it is too close to the 239 keV peak.

If all the criteria are met, GADRAS will utilize all three energy adjustments to determine the offset,
gain, and quadratic terms.

Figure 36 displays the successful completion of the graphical energy calibration for the measured
137Cs spectrum to the computed spectrum.
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Figure 36. Successful Graphical Energy Calibration

6.3. Deviation Pairs Energy Calibration

Scintillator detectors are often non-linear in their energy calibration and require more than two
terms to describe the relationship between channels and energy. Some may require third- and
fourth-order polynomials, but still have substantial error in the energy calibration. Deviation pairs
are a method to describe highly non-linear detectors or to describe the energy calibration exactly for
detailed analyses.

Deviation pairs can be thought of as a supplement to a linear energy calibration. An ideal detector
would follow this linear calibration across all energies of interest; however, this is not always the
case. Deviation pairs can describe the detector's deviation from linearity as a set of energies paired
with the amount of deviation (in energy). GADRAS fits a cubic spline through the deviation pairs to
determine a continuous function of deviation across the entire energy range.

NOTE: Deviation pairs can also be applied to quadratic, or higher-order polynomial fits, but
is not recommended except for advanced users.

The primary benefit of deviation pairs is the level of accuracy that can be obtained without the
artifacts introduced by large coefficients in higher-order polynomials. In addition, the deviation pairs
for a given detector appear to be constant. Thus, even with gain and offset drifting, as long as the gain
and offset can be established with occasional calibration (or automatic calibration), the same
deviation pairs can be applied (without modification) to achieve a high degree of accuracy in energy-
calibration. A further explanation of deviation pairs can be found in Reference [8].
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Deviation pairs are stored in a PCF file (but can also be written to the detector folder to
Deviation.dat for reuse). The current deviation pairs can be accessed in multiple ways. From the
PCF Viewer window under Edit->Deviation Pairs, from the Tools tab, and from the Plot
window under Tools->Edit Deviation Pairs. The only requirement is that there is a spectrum file
currently open and editable.

NOTE: The presence of deviation pairs is indicated in the bottom status bar of the PCF
Viewer window.

For this example, we will use the 3x3\NaI MidScat detector's Cal.pcf, which has deviation pairs
defined. After opening the Cal.pcf file in the PCF Viewer, the Edit->Deviation Pairs option
brings up the Deviation Pairs Editor window as shown in Figure 37. The deviation pairs in a PCF
file can be different for multiple detectors in a single system (for more information on multiple
detectors and naming convention, see Section 0). The editor allows the user to choose which
Detector ID to view/edit. For this file, there is only one detector (Aal). The deviation pairs are
listed in two columns in the text box. The first column is the deviation point (usually a photopeak
energy) in keV. Those are paired with the second column, which is the amount of deviation from
linearity in keV.

Deviation pairs should be reasonably spaced in energy. Placing deviation pairs close together can
cause erratic behavior. They should also be smoothly decreasing or increasing across the deviation
points. Oscillating deviations is an indication of improper use.
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Apply
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Figure 37. Deviation Pairs Editor

Figure 38 shows the 228Th measured spectrum (background subtracted) and its matching calibration
source. The gain looks approximately correct, but mid-range photopeaks are not matched well. This
is a typical starting point for a new detector without any deviation pairs defined. Deviation pairs can
be defined by the following procedure:
• Erase all deviation pairs in the deviation pairs editor and click Apply.
• Ensure there are no third- or higher-order terms in the PCF file by asserting zeros in the

PCF Viewer energy calibration coefficients at the top of the window.
• Plot a measurement which provides good high-energy and low-energy peaks to establish the

gain and offset.

• Using the graphical energy calibration method (Section 6.2), adjust the calibration for gain
and offset. The two peaks used for this are called "anchor points". Insert the anchor point
energies in the Deviation Pairs Editor window with zero deviation and click apply.

• Plot spectra and add deviation pairs as needed.
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Figure 38. 228Th Spectrum without Deviation Pairs

After determining the anchor points (e.g. 239 keV and 2614 keV from 228Th), open the Deviation
Pairs Editor, set their deviations to zero, and click apply (see Figure 39). The plot window shows
vertical blue dashed lines to indicate the location of deviation points. Because these are anchor
points (with zero deviation), the energy calibration is still linear.
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Figure 39. 228Th Plotted with Deviation Pair Anchor Points Applied

The deviation for 583 keV can be set by right-click-dragging the measured 583 keV photopeak.
Figure 40 shows how the plot window looks when this is done. The plot window is outlined in
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purple indicating deviation pair adjustment. The deviation pair is set by right-click-dragging the
measured photopeak (black) to the simulated photopeak (red). GADRAS will regenerate the
spectrum with the new deviation pair, and the deviation will be added to the deviation editor. Figure
41 shows the resulting plot and deviation pair editor. This process can be repeated by plotting
multiple calibration sources, and adding deviation pairs as needed. Users can manually edit the
numbers to tweak the deviation pairs after adding them graphically or to add new ones.
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7. TIME HISTORY

Some detector systems have the capability of taking multiple spectra over a period of time in order
to create a time-segmented series of spectra. By summing spectra over a specified time period, users
can gain insight into a time-dependent scenario that would not otherwise be attainable with
conventional spectra. The Time History tab allows users to plot and manipulate these types of
spectral records. Upon opening the Time History tab, users are presented with a screen involving
several input fields as shown in Figure 42. Users may specify the following:

• File: The file containing the time history spectra
• Foreground Time Segment (optional): Time in seconds to sum over (default: 0 s to end of

file)

• Background Time Segment (optional): Time in seconds to sum over for background-
subtraction (default: none)

• Plotted Particle: The particle(s) of interest to display (default: Photons)

• Plot Styles: specify the plot style for the spectrum types

• Detectors: If there are multiple detectors specified in the file, this panel box specifies which
detectors to display the data from (default: all detectors)

• Plot Computed Time History: Specify if a computed spectrum should be displayed on the
Time History graph display

Figure 42 shows the file as "SearchData.n42". N42 is a common search-file format, which
GADRAS internally converts to the PCF file format. Users can either type the name of the file in
(must be in current detector folder); or open a search file using the PCF Viewer and drag one of the
records into the File field.

Once the file is specified, GADRAS searches for all detector names in the file and displays them on
the right side of the Time History tab as shown in Figure 42. The convention for naming detectors
follows the convention for naming portal detectors:

[A-H][a-d][1-8][N (optional)]

where the first field [A-H] is the "pane', [a-d] is the "column" within the "paner, [1-8] is the multi-
channel analyzer (MCA) within the "column", and [N] is an optional character indicating it is a
neutron detector. This allows for complex detection systems with many detectors to share the same
spectral file, as their energy calibration coefficients may be different. The simplest example is a
detection system with one detector (which has the name "Aar). The example file shown in Figure
42 has eight detectors. They are arranged graphically that is typical of portals. Panels A, B, C, D are
on either side of the inspected vehicle or cargo, panel E is below the vehicle, and panel F is above (E
and F not shown).
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Figure 42. Time History Page

7.1. Plotting Time History Spectra

By default, GADRAS will use all detectors in the Time History plot. Users can check or uncheck
detectors from the Time History tab. After specifying a file and any desired options, the user may
click Plot to display the time history spectrum graph. GADRAS generates two plots as shown in
Figure 43. The first display shows the time history data where the x-axis is the time in seconds since
the data collection started and the y-axis is the total count rate per detector. The second display is
the sum of all spectra contained in the specified time period. By default, the second display shows
the summed spectrum across the entire collection time (in this case, 12 detectors multiplied by 429
seconds each, equals 5148 total time). The right side of the Time History display gives several
options for manipulating the displays. By default, Zoom is selected, which allows users to zoom in
and out of the Time History graph without affecting the sum display. This action is performed by
dragging across the display, similar to normal graph displays.
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Select Foreground allows users to select a portion of the Time History display to sum across.
When this option is selected, dragging will generate a red rectangle which indicates the portion of
the spectrum that is being summed (Figure 44).
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Figure 44. Selecting a Foreground to Sum Over

Upon selection of a foreground, the Time History Sum display updates automatically to display the
sum over the selected time region (Figure 45). As shown, the title of the spectrum reflects the
specified time interval ("Foreground: 273s to 299s").
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Figure 45. Time History Sum over Selected Time Interval

Users may elect to display a background-subtracted spectrum. To do this, the user should click
Select Background and select the portion of the Time History display corresponding to the
background. Dragging will generate a blue rectangle, which indicates the portion of the spectrum to
sum over and use as the background as shown in Figure 46. Note that the summed foreground and
background spectra will be normalized by time and thus display the background-subtracted count
rate for the selected regions. The resulting background subtracted spectrum is shown in Figure 47.
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Figure 47. Background-Subtracted Spectrum

When the user specifies a foreground or background on the Time History graph display, the main
page is being updated with this information, as shown in Figure 48. The user may specify the
foreground or background on this page and click Plot to update the graph display forms
appropriately.
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Figure 48. Foreground and Background Time Periods Are Updated on the Main Display

In addition to dragging across the spectrum or manually specifying the times on the main form,
there are several ways to specify the foreground and background time segments. If the segments are
already displayed on the time history display form, users can drag the edge of the rectangle to move
the boundary to a different time position. The time sum spectrum will automatically update when
the boundary position is selected. The user may also right-click inside the rectangle and choose to
delete the selection or manually specify the boundaries for the selection. The final way to change
the time selection is to right-click drag the time selections. Doing this preserves the time duration,
but changes its start/end time.

7.2. Saving Time History Spectra

Users may save time history selections for future plotting or analysis routines by clicking Save Sum
in the top-right corner of the Time History display form. Doing so will initiate the Save Sum
Spectrum form as shown in Figure 49. For most situations, the default values will suffice for the
user, but there may be some scenarios in which the user may want to deviate from the defaults.
Users can specify the following fields:
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• File: The name of the file to save the summed spectrum to

• Start Record: This field generally increments as users save spectra to the file; users may
change this to overwrite previous records or start saving future records

• Foreground Title: The title of the foreground record; default is "Foreground <start time>
to <end time>"

• Include background in output file: If a background is selected in the Time History display
form, the background selection will be saved when this is selected; it will be saved as a
separate record from the foreground

• User defined background: If the user has defined a background, this selection will be
saved

• Background from file (if present): If the file has a background record associated, this
record will be saved as the background in the new file

• Calibrate and Rebin Spectra: During the summation, GADRAS will attempt to shift the
gains for each detector individually as a function of time to match common background
peaks, and then rebin the spectra into a linear energy structure defined by the Offset and
Full-scale energy

• Rebin Spectra: GADRAS will rebin the spectra into a linear energy structure defined by the
Offset and Full-scale energy

• Offset (keV): The Oth order parameter of the new energy calibration used for rebinning

• Full-scale energy (keV): The 1st order parameter of the new energy calibration used for
rebinning

• Combine spectra or keep the separate?: This group box will be enabled if there are
multiple detectors displayed in the Time History display form

• Output only sum spectrum for all detectors (default): Sums spectra for all detectors and
combines them into one record

• Write separate sum spectrum for each detector: Writes the sum spectrum for each
detector as its own record (foreground and background)
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Figure 49. Save Sum Spectrum Form

7.3. Computed Time History

GADRAS can compute a time history spectrum and either display it individually or overlay it on a
measured time history spectrum. Checking the Plot Computed Time History checkbox, the
computed spectrum parameters appear along with several options near the bottom of the page
(Figure 50). Users may choose to specify parameters for photons or neutrons, indicated by the
selected tab at the top of the computed spectrum parameters. The computed spectrum calculations
assume that the source is passing by the detector at a constant speed. If there are multiple sources,
the calculations assume that all sources pass by the detector at the same speed. The parameters are
defined as follows:

• Rel. speed (m/s): The speed at which the source(s) pass by the detector face

• Min. distance (m): The minimum distance from the detector that the source(s) are relative
to the detector face

• Bkg. count rate: The background count rate across the entire time history spectrum;
assumed to be constant across the entire contents of the file

• Time to src 1(s): The time in seconds until the first source is in front of the detector

• Peak cps 1: The maximum count rate the detector sees for the first source
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• Length src 1 (m): The length of the first source in meters

• Separation n (m): Separations 2-10 indicate the distance between the current source and
the previous source

• Peak cps n: The peak count rate for source n

• Length src n (m): The length of source n

• Cos power #1, Cos power #2, Fraction #2 power: Parameters for manipulating the shape
of the peaks (defined further below)

• % Template error: Chi-square is calculated based on statistics in spectrum plus an overall
factor defined by this parameter (generally -10%)

• Chi-square for fit: Statistical parameter defining how well the fit adheres to the measured
spectrum

• Average error (%): The average amount the fitted spectrum is off of the measured
spectrum

• Peak / average: Factor defining how far the peaks are above the overall average spectrum
count rate
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Figure 50. Time History Page with Computed Spectrum Options

Save To File will write the specified parameters to a file for future use. Photon parameters are
saved to a file with extension PAS, and neutron parameters are saved to a file with extension
NAS. Similarly, Load From File loads previously saved parameters from a file and populates
the appropriate fields.
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GADRAS can fit a computed spectrum to a measured time history file. Users can select any
property to vary by clicking the label of the parameter. Clicking the label of a parameter will
highlight the parameter's text box, as shown in Figure 50. Any parameters that are highlighted
will vary when the user clicks Fit Data. The computed spectrum before and after fitting the
peak count rates is shown in Figure 51.
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Figure 51. Computed Spectrum before Fit (top) and after Fit (bottom)

The parameters Cos power #1, Cos power #2, and Fraction #2 power determine the shape of the
peaks for the source objects. If a bare spherical source passes by a bare detector, the source will
have the same shape at all points in time, and thus the Cos power #1, Cos power #2, and Fraction
#2 power will all be 0. However, if the detector or source is shielded on the sides, the source will
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appear differently at different positions. The equation for the rate at different locations take the
form

R = R0[(1 — Frac)cos.):13119 + (Frac)cosP29] (5)

where 0 is the horizontal angle from the source to the detector, R is the count rate at angle 0, Ro is
the count rate of the source when the source is directly in front of the detector (0=90 degrees), and
Frac, P1 , and P2 are empirical parameters to be fit to the measurement. In the above equation, P1
corresponds to Cos power #1, P2 corresponds to Cos power #2, and Frac corresponds to Fraction
#2 power.
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8. ANALYZING SPECTRA

8.1. Graphical Analysis Using Plot Overlays from Library

The GADRAS plot window allows for some primitive spectral analysis. Energies from measurement
peaks can be compared with library spectra from the Isotope Database or the PhotoPeak List.

The left side of Figure 52 shows an example where the PhotoPeak List form is used to overlay a
computed spectrum for 88Y (cyan) with the measured spectrum. This display is presented after
shift+clicking on the 1836 keV peak. The activity of 88Y in this sample is estimated to be 8.63 uCi
shielded by 11.9 g/cm2 of material with atomic number 94. The PhotoPeak list is shown on the right
side of Figure 52. If the overlay does not match, another peak may be chosen for comparison with
the measured spectrum.
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8.2. Numerical Spectral Analysis

GADRAS is designed to perform robust full-spectrum analysis. Once a detector calibration has been
performed, various analysis techniques can be used to identify peaks and estimated source
information. The Analyze tab on the main window provides options for numerical analysis options,
which include:

• Single Regression

• Multiple Regression

• ComputeFlux
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The Analyze tab shown in Figure 53 contains a table with measurement information, similar to the
Plot tab. Display options for the analysis output are located on the bottom of the Analysis tab. The
ensuing plot will only subtract the background if the Strip background option is selected. If no
background is specified, GADRAS will attempt to estimate the background based on features in the
measurement.

For the analysis algorithms to function properly, the distance from the front face of the detector to
the center of the source must be known or assumed to correctly calculate the intensity of the source.

There is also an option to perform an analysis routine on a time history file by clicking the Time
History button. This will perform the analysis on the time-summed spectrum. If the user updates
the foreground or background time segments, the analysis routine will automatically perform a new
analysis, unless the analysis takes a long time (e.g. ComputeFlux). In this case, after the user selects
the foreground and background segments, they may click Analyze on the Time History display
form.
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Figure 53. The Analyze Tab on the Main Form
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Figure 54. Compute Spectrum Analysis on Time History File

8.2.1. Source Libraries

Several source libraries are generally available for inclusion in regression analysis, shown in Figure
53.

The available source libraries are:

• Isotope

• Xray

• AIP

• Benchmark

• CaptureGammas

• Continuum
• DHS

• Neutron

• SNM

• DetectorFolder

Most of these libraries match the subfolders of the Source directory (usually located in
CAGADRAS \ Source). Other libraries can be created by the user by making new subdirectories
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under C: \GADRAS \Source. Each library/directory contains files that define emission rates of
gamma-rays or neutrons.

Within each library is a list of sources that can be selected for use in the current analysis. Sources
can be selected by clicking on the source. Multiple Regression analysis allows for multiple sources to
be included in the analysis results.

The most commonly used library in a typical analysis is the Isotope library. Figure 55 shows the
Isotope library window with several isotopes selected (orange). Users may select various groups of
isotopes in the Group Selection Options portion of the window. The group selection capability is
provided only to save time in selecting an isotopic group. The groups include:

• Fission — common fission daughter products

• Natural — naturally occurring isotopes commonly found in measurements

• Medical — typical isotopes used as radiopharmaceuticals and sources for imaging and
therapeutic use

• Calibration — isotopes often used as laboratory calibration sources

• SNM — isotopes typical of uranium and plutonium

• Automatic — automatically chooses potential isotopes from the library based on a simple
peak identification algorithm

y Source Librari: kotope 0 X

Group Selection Options

❑ Fission

2 Natural

❑ Medical

❑ Calibration

D SNM Select All
OK

Cancel
Automatic Clear All

The 56Co 77I3r 93Y 105.Rh 1255b 133Xe 146Pm 182Ta 208T1 234Th 240Pu
16N 57Co 82B r 89Zr 103Ru 1265b 133Xem 153S m 186Re 209T1 231Pa 241Pu
18F 58Co 85Kr 93Zr 105Ru 123Tem 135.Xe 150Eu 187W 212Pb 233Pa 242Pu
22Na 60Co 85Krm 95Zr 106Ru 129Te 132Cs 152Eu 133w 214Pb 233U 241Am
24Na 62Co 88Kr 97Zr 99Rh 129Tem 134Cs 154Eu 190Ir 20713i 232U 243Am
31Si 62Com B2Rb 91N b 1OORh 132Te 136Cs 155Eu 192Ir 214Bi 234U 243Cm
32P 66Ni 8.3Rb 91N b m lO2Rh 1231 137Cs 156Eu 1941r 210Po 235U 244Cm
3-BC1 64Cu 86Rb 92Nb 102Rhm 1251 133Ba 153G d 1941rm2 2O7At 236U 24SCm
41Ar 67Cu 83Sr 92Nbm 103Pd 1261 14OBa 160Tb laspt 7P 2Rn 237U 249Cf

63Zn 85Sr 94N b 110Agm 1311 138La 166H o 197Pt 223Ra 23-8U 252a
42K 652n 87Srm 95N b 109Cd 1321 14OLa 166H... 198Au 226Ra 239U
46Sc 67G a 89Sr 95N b m 115.Cd 1331 139Ce 167H o 199Au 227Ac 236Np
51Cr 68G a 90Sr 97N b 1111n 1341 141Ce 169Yb 203H g 228Ac 237Np
54M n 72G a 915r 97N b m 1135n 1351 143Ce 176Lu 200T1 227Th 239Np
56M n 68G e 92Sr 99Mo 1255n 127Xe 144Ce 177Lu 201T1 228Th 236Pu
S2Fe 76As 88Y 39Tc 122Sb 129Xem 147Nd 177Lum 202T1 229Th 23-8Pu
59Fe 755e 92Y 39Tcm 1245b 131Xem 145Pm 175-Hf 204T1 .E12Th 239Pu

Figure 55. Isotope Library Window
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Fitting the continuum caused by the presence of a neutron source cannot be done by selecting a
neutron emitter (e.g., 252Cf) from the gamma-ray Isotope library. Instead, it must be done with an
appropriate selection from the Neutron library.

8.2.2. lntroduction to Linear Regression Analysis

GADRAS contains two linear regression analysis routines. The two routines, located on the
Analysis screen, have the same user interface and analysis approach, but are used for different
purposes.

• Single Regression performs a chi-square (x2) analysis to rank individual gamma-ray sources
to a radiation measurement. This option should be used when it is anticipated that only one
source heavily dominates the spectrum.

• Multiple Regression performs a chi-square (x2) analysis with the assumption that several
gamma-ray sources are contributing to a measurement. For example, in the case of a
radioactive fallout measurement, several radionuclides will be present and should be included
in the analysis.

Both analysis routines report a x2 metric, which indicates the deviation between the measured data
and the fit (relative to estimated uncertainties in the two sets). If the data is of good quality, has a
good energy-calibration, and the detector-response function is good, the value of x2 should be near
1.0 if the fit matches the data.

The spectrum to be analyzed is determined by the what is included in the measurement table at the
top of the Analyze page. Shielding parameters can be estimated to characterize effects associated
with intervening materials. The shielding parameters describe intervening materials by an effective
atomic number (AN) and areal density (AD). Selected sources are ranked for consistency with the
measurements when Single Regression is performed and more than one source is selected.
Multiple Regression finds the combination of selected sources and associated activities that gives
the best fit to the spectrum. Parameters associated with intervening materials can be varied for the
best fit by clicking on the AN and AD labels (clicking these labels highlights the adjacent boxes,
turning them orange). There is also a check box for the option of allowing independent shielding for
each radioactive source in the measured spectrum (only for use in Multiple Regression).

8.2.2.1. Single Regression Analysis

The Single Regression option ranks individual gamma-ray sources for their similarity (x2) to a
radiation measurement. It is used when it is anticipated that one source heavily dominates the
spectrum. Any combination of sources can be selected by the user from the available source libraries
(see Section 8.2.1). Figure 56 shows the Single Regression tab with selected sources. Clicking the
Analyze button will perform the analysis.

93
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Figure 56. Single Regression Analysis Tab

Single Regression analysis generates a plot of the single nuclide that best fits the data and a
summary page. The best fit is plotted as shown in Figure 57, and the summary page (Figure 58)
ranks the selected isotopes based on similarity to the measurement using the reduced chi-square (x2).
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Figure 57. Single Regression Analysis Results of Unshielded 88Y Spectrum
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88Y, 5.3EuCi

Figure 58. Single Regression Analysis Summary Page
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8.2.2.2. Multiple Regression Analysis

The Multiple Regression analysis algorithm finds the combination of sources that gives the best fit
to the measured spectrum. A reverse regression technique is used in which a combination of all
spectral templates is utilized. Subsequent iterations gradually remove sources that do not contribute
to the fit.

When performing this procedure, users have the option to allow an intervening, adjustable
absorber/shield to obtain the best fit. This is done by activating the boxes labeled AN and AD.
Calculations can take several minutes if many sources are selected, especially if the shielding can
vary.

Figure 60 shows the Multiple Regression tab with the same 88Y spectrum in the foreground, except
we have now also removed the background subtraction to allow the multiple regression to fit the
background components. We have also allowed the shielding AN/AD to vary, as well as allow
independent shielding for each radionuclide.

The Multiple Regression analysis routine generates a single graph of the group of nuclides that
best fits the data and a summary page. The graph will indicate the relative effects of each isotope in
the overall fit if the Fill Templates option has been selected. The graph shown in Figure 60
displays each selected source's contribution. The summary of the multiple regression analysis results
shown in Figure 61 displays the analysis results in text form (isotope list, activities, weights, and
shielding information). The text string found at the bottom of the summary page can be copied and
pasted to the source line (Source for Computed Spectrum) on the Plot tab for plotting as an overlay
for comparison with measured data.
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Figure 59. Multiple Regression Analysis Tab
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8.2.3. Compute Flux

The ComputeFlux algorithm can be selected as shown in Figure 62. The ComputeFlux tool
estimates the incident flux from the measured spectrum by performing nonlinear regression analysis.
Prior to analysis, the user should select the appropriate spectral files for the foreground and
background. A graphic plot of the results displays peak and continuum terms as shown in Figure 63.
The flux profile is also saved in a file with a GAM extension.

Normally, the radiation is assumed to be going through the front of the detector. The Compute
flux as background option will assume the radiation enters all facets of the detector.
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Figure 62. ComputeFlux Analysis Tab
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9. NEUTRON DETECTORS

The Neutron tab allows users to model neutron detectors. Neutron detector response information
is stored in files named Neutron$XX.gadras, where "XX" is the name of the neutron detector.
Neutron detector files must be stored in a gamma detector directory and thus be associated with a
gamma detector. If a scenario arises in which no gamma detector was used, users must create a
"dummy" gamma detector before they can access the Neutron tab. Doing this will not affect the
neutron detector results. If no neutron detector is associated with the current gamma detector setup,
the Neutron tab will look like Figure 64.

)13 GADRAS 18.8.0 NeutronDemo 0 X

Detector Plot Time History Analyze Model Neutrcm Inject Tools Setup

File Help

Characterize

Detector Parameters

F:o:pon:e Feynrnan-Y

Moderator Width lcmic 103 Adjustable Parameters

Moderator Height lcmic 10,29 Efficiency enhancement: 0.32

Setback lin* 0 Polyethylene front (cm): 1.4

Thermal Cutoff Ba ck and Sides 0 Polyethylene back (cm): 1.66

Detector Neutron Lifetime (ps): Thermal cutoff front (eV):30 0

Reset All

Calibration Measurements

Environment Indoors above suspended flc •-•

Distance (cm): 50

Height Above Floor (cm): 100

Calibration Source: 252CF_2641

Date of Measurement 09/16/2003

Equiv. Cf-252 Activity: 53.7 ski or 2.31E+5 n/s

Fit to

Calibration

Set Neutron Background Lat: 35 Long: 253A Elev: 1620 Overburden: 105 Chi-Square: 28.4 • ror Of* 5224

Figure 64. Neutron Tab without Selected Neutron Detector

9.1. Creating a New Neutron Detector

Users can create a new neutron detector by clicking on the File menu, then Create New Neutron
Detector. A new form will appear prompting the user to input parameters to create a new neutron
detector (Figure 65). Users must enter a name for the detector, the source-to-detector distance in
cm, and the height of the detector in cm. Users may then either choose to clone a common detector,
clone an existing detector, or create a new detector from known parameters.
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100.0

1.0

1.0
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100.0

1.0

Cadmium Cover ❑

Create

Cancel

Figure 65. Create New Neutron Detector Form

To clone a common detector, users can select a detector from the drop-down list and click Clone.
To copy an existing detector, users can click Browse and navigate to the existing detector file
(Neutron$*.gadras). This detector file can be in another directory. This is useful when the same
neutron detector is used with multiple gamma detectors.

To create a detector from existing parameters, fill out the bottom portion of the form (Figure 65).
The required parameters are:

• Moderator Area (cm^2): the surface area of the moderator surrounding the detector as
seen by the source

• Front PE Thickness (cm): the thickness of polyethylene in front of the detector as seen by
the source

• Back PE Thickness (cm): the thickness of polyethylene behind the detector as seen by the
source

• Eff. Enhancement: used to resolve differences between observed and computed
efficiencies

• Cadmium Cover: checked if the detector is surrounded by cadmium

After specifying the parameters, click the Create button to create a new neutron detector.

9.2. Neutron Detector Characterization

After creating a neutron detector, the parameters on the Neutron tab are activated and the initial
settings are filled in. Users can then fill in more information about the neutron detector:
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• Moderator Height (cm): the vertical height of the moderator

• Moderator Width (cm): the horizontal width of the moderator
• Setback (cm): the distance from the front face of the detector to the moderator face

• Thermal Cutoff Back and Sides or % Covered by Cadmium: the energy at which
neutron are killed if they enter from the back or sides of the detector housing, or the percent
of the detector covered by cadmium

• Detector Neutron Lifetime (vs): the average lifetime of a neutron in the detector in
microseconds

After the initial detector parameters are input, the Calibration Measurements section can be
completed. The first drop-down menu describes the overall scattering environment for the
calibration measurements. The following options are available:

• No reflected neutrons: the environment does not scatter any neutrons into the detector
• Outside or large bay: the environment scatters neutrons only from the floor

• Inside above suspended floor: neutrons are scattered from the walls and floor; the floor is
assumed to be above ground and thin

• Inside above concrete on ground: neutrons are scattered from the walls and floor; the
floor is assumed to be infinitely thick

The following parameters should be filled in before attempting to characterize the detector:

• Distance (cm): The distance from the center of the source to the detector face

• Height Above Floor (cm): the height of the detector above the floor

Once the parameters are filled in, characterization measurements using 252Cf should be recorded.
The calibration source should be in the source database (see Section 11.1.1). The name of the source
is 252CF _serialN umber where serialNumber is the identifying serial number of the 252Cf source. The
date of the measurements should be recorded. Once this information is present, GADRAS_DRF
will calculate the activity of the source during the measurements and display the information in the
corresponding textbox. Alternatively, users can input a known activity of 252CF (e.g.
"252CF,100uC") into the name field; however, this is not recommended.

A range of moderated 252CF sources is required for GADRAS to determine the proper energy-
dependent response function of the neutron detector. Measurement information for each moderated
source is recorded in the table on the bottom of the form. The source configuration can be selected
from the following:

• Background: measurement taken with no source

• Cf252-Bare: measurement taken with bare 252Cf source (no shielding or moderator on
source)

• Cf252-XXcm-PE: measurement taken with XX cm of polyethylene surrounding the source

• Cf252-XXcm-BPE: measurement taken with XX cm of borated polyethylene surrounding
the source
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For each measurement, the Live Time and the total number of counts should be recorded in the
table. The net count rate will be computed automatically. The computed count rate will be
computed based on the parameters entered in the form. The Neutron Background button will
bring up the Neutron Background form (Figure 66). This form determines the cosmic flux that can
be expected during the count. Users can select a pre-defined location from the dropdown list, or
they can input the latitude, longitude, and elevation themselves. Users should specify whether the
experiment was taken in a building below multiple floors, or they can specify the areal density
themselves. The reference date can be changed to match when the measurement was taken. As a
reference, the cosmic neutron rate relative to the average rate New York City is given.

n Neutron Background X

Cosmic Radiation

Albuquerque, NM (airport)

Latitude (deg N):

Longitude (deg E):

Elevation (meters):

Floors Above:

or g/cmA.2:

Reference Date:

3.5

253.4

1520

09-Apr-2013

Rate Relative to Mean in NYC: 3.707

Cancel OK

Figure 66. Neutron Background Form

The Adjustable Parameters box holds parameters that can be optimized to improve the neutron
detector model. By clicking the label of the adjustable parameter, users can specify whether they
want the parameter to be adjusted. By clicking the Fit button, GADRAS will optimize the
highlighted parameters using an iterative non-linear regression algorithm. The computed count rate
in the measurement table will be updated with the optimized parameters. Clicking the Clear button
will reset all parameters on the form.

9.3. Neutron Response

The response function of the neutron detector to any measurement scenario (different from the
calibration measurement scenario) can be analyzed in the Response tab. Users can see the efficiency
of the detector plotted in red. Users can specify the measurement environment, the distance, and the
height for the measurement.

Once a source GAM file (or 252Cf activity) is specified in the GAM/3DM File field, the leakage
from the source will be plotted in blue. For SNM radionuclides like 240Pu, this does not include any
shielding or potential multiplication from fission. To include these effects, users must have a GAM
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file derived from a model. The units for neutron leakage are changed in the Plot Options box. The
choices are:

1. Diff. Neutron Leakage (n/eV/s): this is the neutron group leakage into 47r, with each
group divided by the group-width in eV

2. Neutron Leakage (energy * diff. leakage (n/s)): this is the differential leakage as
described above, multiplied by the average energy of each group (default)

In addition to the plot, the leakage from the source, estimated multiplication, detector count rate,
intrinsic efficiency and absolute efficiency fields are populated. Here, intrinsic efficiency is defined as
the percentage of neutrons that are detected, given they strike the neutron detector. The absolute
efficiency is defined as the percentage of neutrons that are detected that leak from the source.

There is also a Quick Source Activity Estimate box which allows users to input a recorded count-
rate from a detector. GADRAS will estimate the equivalent bare and moderated 252CF activity at the
specified distance/height/measurement environment.
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Figure 67. Neutron Response Tab
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9.4. Neutron Feynman-Y

GADRAS can analyze and compute Feynman-Y plots. Figure 68 shows the Feyman-Y tab on the
GADRAS Neutron page. Users can display a multiplicity measurement using the Measurement text
box. Users can also calculate the Feynman-Y distribution from a 1-D model by using the
Calculation text box.
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Figure 68. Neutron Feynman-Y Page
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10. INJECT CALCULATIONS

10.1. Creating Inject Data

GADRAS has the capability of synthesizing spectra and save them to a file. The results of these
computations are called inject spectra and can be used for a variety of purposes, including training,
sensitivity analysis, and minimum detectable activity tests. The main sections in the Inject page are
general settings, neutron settings, detector settings, and background settings. The inject page is
shown in Figure 69.
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Longitude (deg E):

Elevation (meters):

Floors Above:

or g/cr02:

36.1

244,8

670

5

200

❑ Include Cosmicfrom Location

Terrestrial Background 2 Include
Estimate NORM for Location

K%:

U ppm: III

Th ppm: III

Attenuation:

Low-E

Continuum:

High-E

Continuum:

0

a

6

4.1

Make Batch Run Batch Compute

Figure 69. Inject Page

10.1.1. General Settings

Users may specify a variety of properties when creating inject data. The general settings include:

• Date/time: The timestamp that should be assigned to the spectrum; users may type in a
date and time or select one from the calendar icon

• Output File: The file to write the inject data to

• Record: The record in the file to write the inject run to

• Title: The title of the run
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• Source (optional): The source information to include in the inject data; this field is similar to
the Computed Spectrum table on the Plot page (Section 4)

• Distance (cm): The distance between the source and the detector face

• Height (cm): The height of the detector above the floor for this scenario

• Time (s): The amount of time that should be simulated for the run; users may also specify
whether this is Live time or Real time

• Apply Poisson Statistics: When this box is checked, the inject data will have a Poisson
distribution which simulates real measurement data; when unchecked, the data will be
perfectly conformed to theoretical calculations

• Internal.pcf: If the detector has internal radioactive components (e.g. LaBr) or calibration
sources attached to the detector, there may be a file called Internal.M.in the detector folder,
which contains the spectrum associated with the internal source; this checkbox allows this
spectrum to be included in the inject data file

10.1.2. Neutrons

Some detectors have neutron detectors attached to them. This section allows a user to also compute
the count-rate from the neutron detector and embed that information into the spectrum file. For a
neutron detector to be available, the neutron detector file must be present in the current detector
folder.

The Reflection Environment is also important for gamma detectors measuring neutron sources, as
it will change the rate of incident neutrons on the gamma detector, and thus the observable neutron
interactions in the gamma detector. This is described in more detail in Section 9.2

10.1.3. Gamma Detector

Uscrs may desire to change the detector settings from the default settings (imported from the
current Detector.dat file).

• Dead time per pulse affects the recorded live-time of the simulation. Typical values are
between 10 and 20 microseconds.

• True Energy Calibration is the energy calibration parameters used to determine the
channel group structure for the simulated spectrum. This can also be used to change the full-
energy-range of the detector by changing the Order 1 to the full energy in keV.

• Recorded Energy Cal is what is recorded in the spectrum file. This may be different than
the true calibration to simulate uncalibrated or poorly calibrated spectra.

• Resolution parameters allow users to simulate subtle differences between different
detectors of the same type, which have different resolution, or may have resolution changes
with time or temperature.

Clicking the Defaults button will adjust the energy calibration and resolution parameters back to the
default parameters assigned to the detector.

10.1.4. Background Settings

Background radiation primarily comes from two sources: cosmic and terrestrial. Cosmic radiation
contribution to the spectrum is determined by the latitude, longitude, elevation, and solar cycle (date
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and time provided). In addition, the user can specify how many building floors are above the
detector (or equivalent areal density of shielding material) which also affects the cosmic radiation.
Terrestrial background is mostly composed of 40K, the uranium decay chain, and the thorium decay
chain. The following settings can be specified regarding background:

• Location (dropdown menu): The latitude, longitude, and elevation for many cities across the
world are stored in GADRAS; selecting an option from this dropdown menu will
automatically fill these fields in the location info

• Latitude (deg N): Latitude of the simulated measurement

• Longitude (deg E): Longitude of the simulated measurement

• Elevation (meters): The elevation of the simulated measurement

• Floors Above or g/cm^2: Users may specify the aerial density of the material above the
detector if it is known; otherwise, users may specify the Floors Above parameter and the aerial
density will be estimated; this is used to generate the cosmic background attributed for the
simulated spectrum

• Include (terrestrial background checkbox): Specifies whether terrestrial background
calculations should be included in the simulated spectrum

• K%: The weight percentage of potassium in the soil; for reference, 1% corresponds to 7.8 g
of 40K (54.47 [IC) in a 1 meter radius sphere

• U ppm: Amount of uranium in soil in parts per million; for reference, 1 ppm corresponds to
2.236 p.Ci 238U, 2.236 µCi 226Ra, and 104.2 nCi 235U

• Th ppm: Amount of thorium in soil in parts per million; for reference, 1 ppm corresponds
to 6.7 g 232Th (732.3 nCi) in a 1 meter radius sphere

• Attenuation: Amount of attenuation the terrestrial background goes through before
encountering the detector

• Low-E Continuum: Amount of low-energy continuum the terrestrial background will
contribute; this can be based on materials between the soil and the detector or how much
soil is present near the detector

• High-E Continuum: Amount of high-energy continuum the terrestrial background will
contribute

• Include Cosmic: Specifies whether cosmic background calculations should be included in
the simulated spectrum, this is the primary source of neutron background for the
calculations

Users may click the Estimate NORM for location button to estimate the naturally occurring
radioactive material (K, U, and Th) for the location specified in the Location dropdown menu.

NOTE: The terrestrial NORM estimation only works for cities in the U.S., but there are
additional cities listed to get the correct latitude/longitude for cosmic radiation.

Once all the settings have been specified, clicking the Compute button will generate the output.
The PCF Viewer window will open and be populated with the file specified in the Output File text
box. The graph display will also appear and display the simulated inject data. The settings will all be
saved in a .inj file, which has a default file name format of <outputFileName>-
<RecordNumber>.inj. Users may choose to save the settings without running the inject using the
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Save As inject file... option in the File menu. The auto-save feature can be disabled from the
Options menu. Users may also populate the settings from an inject file by selecting Open inject
file... from the File menu.

10.2. Batch Inject

Users may need to generate a large amount of inject data. This can become a tedious process if
done in the traditional way. GADRAS allows users to perform batch inject calculations using a
series of .inj files. Users may create these text-based files themselves, provided they follow the
correct format. To perform a batch inject calculation, users should click the Batch button on the
inject page. This will bring up the batch inject form as shown in Figure 70.

PP. C:\GADRASWetector\InjectDerno — 1=1 X

File name format: *.inj

inject_01_13kgnd.inj
inject_02_13kgnthinj
inject_03_13kgnd.inj
inject_04_Bkgnd.ini
inject_05_13kgnd.inj
inject_05_13kgnd.ini
inject_07.inj
inject_08.inj
inject_er9.inj
inject_10.inj
inject_11.inj
inject_12.inj

-.:1 OK

Number of cores: 12 8

Figure 70. Batch Inject Form

To perform a batch inject calculation, the user selects the desired files to perform the inject
calculations with. If none of the files are highlighted, all the displayed inject files will be included in
the batch calculation. The File name format text box can be used to populate the form with different
files. Files do not need the .inj extension to be used in batch calculations. The user can also specify
the number of cores to use for the selected batch calculations.

10.3. Batch Inject Setup

Manually generating inject files for large batch runs can be tedious and error prone. The Batch
Inject Setup tool enables the user to readily generate batch inject data by a varying a subset of the
available inject variables, such as source, counting time, and detector distance. The tool is accessed
via the Make Batch button on the inject page. There are two modes on the Batch Inject Setup
form: Batch and Pass By, each accessed by their own tab, as seen in Figure 71.
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The Batch Inject Setup page is populated with the current configuration on the Inject Page,
including the settings that cannot be changed on the Batch Inject Setup form, such as the
background and detector settings. These settings can be changed by either returning to the Inject
Page or by loading the inject configuration from another inject file via Load Inject
Template...from the File menu. One can also load the inject settings and the entire Batch Inject
Setup configuration via Load Setup... from the File menu, for both Batch and Pass By modes
via the ".bis" file.
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Batch Inject Setup

Batch Pass By

File Tools View Help

Detecto r Benchmark\ BeRPba II

Cases to Run: 2

Output File

Starting Index

testDev.pcf

❑ Separate Files

2 Make Background
❑ Apply Poisson Statistics

0 Paired 0 Unpaired
Number of Samples

Select Variables to Adjust

Distance (cm)

Height (cm)

Time (s)

Source

Scale Sour[e

1: 200

1: 100

1: 1.3D-03

- 0 X

Advanced Options

AN

AD (g/cm2)

Translate X

Translate Y

1: None

1: None

1: None

1: None

L oop orrler

Figure 71. Batch inject Setup form with the Batch page selected

10.3.1. Batch

The Batch mode is used to generate inject data by adjusting a subset of the available inject variables,
e.g. distance and source. Before adjusting variables, there are a set of parameters that must be set in
the top two boxes.

• Output File: the name of the spectral file where all the resulting inject data will be stored.
Must be either a ".pcf "or ".n42" file

• Starting Index: This is the index the inject data will be appended at. It is automatically set
to the next free record, if the file already exists

• INJ Output Directory: The Batch Inject Setup can create a multitude of files in the
detector directory, which can be automatically moved to this directory after the Batch run
completes

• Save INJ Files After Run: If not selected, the inject files generated are deleted.

• Separate Files: Writes a single inject spectrum to a file, such that each spectral file contains
one record

• Make Background: If selected, background inject records will be made. Paired
background gives a background with every source containing record. Unpaired generates all
the background first, and then the source records follow.

• Apply Poisson Statistics: When this box is checked, the inject data will have a Poisson
distribution which simulates real measurement data; when unchecked, the data will be
perfectly conformed to theoretical calculations. Number of Samples is the number of
Poisson samples taken of the inject data.
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There are two categories of variables: Select Variables to Adjust and Advanced Options, the
former requires a value to generate inject data and the latter are optional. For all variables, the Reset
button restores the variable to its original data, and the button with the variable name launches a
new input form, seen in Figure 72 .

Input Data 0 X

Setvalues for Distance, Val in File = 50

Select automatic or manual data entry

0 Auto 0 Manual

Auto Data Entry

Steps 9 Min 10 M ax 100

10
20

30
40

50
50
70

80
90
100

lniport File

GO Input Data CI X

Set Values for Distance, Val in File = 50

Select automatic or manual data entry

0 Auto Manual

Manual Data Entry

Entry 14 Enter

10

12

Delete Clear

Import File Cancel

Figure 72. input Data form for numerical value variables, in Auto and Manual mode

There are three ways to enter the values for a variable. First is Auto, where the user specifies the
number of uniform sized Steps to generate values between Min and Max, including the limits.
Next, is Manual where numbers are simply entered. The Delete button allows the user to remove
selected values and Clear removes all entered values. Finally, Import File allows the user to load a
text file, with a single number on each line, as the values for the selected variable.
The Source variable has a special input form, as seen in Figure 73. There are five ways to enter
sources. The buttons D and S, open a file browser for sources in the detector and source folders,
respectively. The CSV button allows the user to select sources from a user generated ".csv" file that
contains the gam file name and a description column. The remaining methods of entry, are Manual
Data Entry, where you simply type source and by Import File, which obeys the same rules as the
numerical value input form.
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0.-; Input Data D X

Set Values for Source, Val in File = 137COuC

Add Source(s)

Manual Data Entry

Entry Cont50 Enter

137Cs,10mC

60Co,SmC-F22Na,10mC

Delete Jur

Import File Cancel Ck

.:E

Figure 73. Input Data form for Sources

The normally collapsed section on the Batch Inject Setup form, called Loop Order, is an
advanced option, that allows the user to set the order the variables will be displayed in the spectral
record. For example, one could vary Distance before Height, or vice versa. The data would be the
same, but the order of the inject data would change.

Once all variables have been set, one can either write the inject files without running them using the
Write button or perform the inject calculations by using the Run button, where the files are saved
or not depending on the state of the Save INJ Files After Run. After a Write, Run, or File->Save
Setup As... a ".bis" file is generated that saves the current setup of the Batch tab. If a Run or
Write is performed a csv file is generated that maps the spectral record to the inject configuration.

10.3.2. Pass By

The Pass By tab, as seen in Figure 74 , allows users to simulate a source and detector moving
relative to each other. Most page behavior is the same as the Batch tab. One can no longer write a
single spectral record to its own file, but can write paths to their own file by selecting Separate Files
for Each Path. The Make Background box now requires one to enter a Count Time(sec) for all
backgrounds, which are always at the beginning of the spectral record.
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Batch Inject Setup

Batch Pass By

File Tools View Help

Detector Benchmark\ BeRPball

Configurations to Run: 0

Output File

111 Use Portal

testDev.pcf

2 Nlake Background Count Time (sec)

❑ Apply Poisson Statistics Number of Sample

Sou rce Variables to Adjust

Source

Scale Source

Height (cm)

1: 1336a,1001u.0

1: 1

Advanced Options

AN

AD (g/cm.2)

Translate Y

1: None

1: None

1: None

- LI X

Pass By Paths

Integration Method I MeanValue Sarnpled Points

Add/Edit Pass By

Independent

Distance

Start

Interval

•••

sec

Coupled

Speed

0 End

0 Segments

m eter/s

rn

Add

Pass Byts)

Segments Interval(s) Distance(cm) Sp eed(cm/s) Start(cm) En d(crr)

Ed it Delete If ad

Cancel Pin

Figure 74. Pass By tab

The Source Variables to Adjust and Advanced Options buttons behave exactly as they do in the
Batch tab. The Pass By Paths button launches a new form, as seen in Figure 75, to define the
relative motion between the source and detector. Each field must be completed and each input
supports multiple units, selected in the adjacent dropdown.

Add/Edit Pass 13y(s)

Add/Edit Pass

Closest Approach

Starting Position

Count Time

Pass By(s)

5

-2

Ft

m

sec

Speed

Ending Position

Measurements

1.12

8

29

rriesehr

m

New

Meaurernents

4

16

Time(s)

1

Distance(cm)

1524

152.4

Speed(crn/s)

124 995977

49.5999524

Start(crn)

-200

Endfcm)

300

300

Import Rle

UPdate 

Add

DdEle

Edit

Cancel OK

Figure 75. Add/Edit Pass By(s)
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There are two types of variables to set in the Add/Edit Pass By form: fixed and complimentary
variables. Fixed variables are set by the user and complimentary variables are those that the program
may vary to insure an integer number of Measurements. The fixed variables are in the left column
and complimentary are the variables in the right column. The top section of the form is the
Add/Edit Pass By(s) section, where paths are defined. The Pass By(s) table stores all the paths to
be used in the inject calculations. The path values are displayed in the units used by GADRAS but
when edited display the units used to defme the path.
• Closest Approach: (Fixed) The minimum distance between the source and the detector.

The point of closest approach is fixed at x=0, usually between the Starting Position and
Ending Position.

• Starting Position: (Fixed) The initial position of the "Pass By", relative to x=0, as defined
by the distance of Closest Approach. The Starting Position can be positive or negative,
allowing for left-to-right and right-to-left paths

• Count Time: (Fixed) The time for a single measurement. Multiple measurements are taken
along the path, each with a duration of Count Time

• Speed: (Complimentary) The speed the source and detector move relative to each other
between Starting Position and Ending Position. Must be a positive number, the direction
of travel between the source and detector is determined by the Starting Position and
Ending Position. Must have units defined to use Update to set a value.

• Ending Position: (Complimentary) The end of the path, as defined relative to x=0, as
defined by the distance of Closest Approach. Does not have a unit drop down, because it
has the same units as Starting Position

• Measurements: (Complimentary) The number of measurements that will be taken along
the path. This value must be an integer.

• Update: This button becomes active when all fixed variables have been assigned values and
units, and two out of three complimentary variables have been completed. Pressing Update
will autocomplete the remainder of the form or ask which complementary variable should be
adjusted to ensure Measurements is an integer.

• New: Sets all the fields in the Add/Edit Pass By section to empty.
• Add: Will become active only when the all path criteria have been satisfied, such as values,

units, and an integer number of Measurements. Pressing Add will save the current path to
the Pass By(s) table and clear the Add/Edit Pass By(s) section.

• Delete: Removes the path selected in the table
• Edit: Copies the path selected in the table to the Add/Edit Pass By section of the form,

where the path can be modified. The original path used for Editing will remain unchanged,
and a modified/copy of the path can be added.

• Import File: Allows the user to load a text file of paths, where each path is defined on its
own line. The format for a path is that used by the ".bis" file for saving the Batch
configuration.

The next options to consider are the Integration Method and Sampled Points. The Integration
Method determines how each measurement along a path accounts for the relative motion of the
source and detector, which can be crucial is the source-to-detector distance varies significantly along
the path. The path integration along a subsegment of a path, where we count for a single Count
Time, sums a set of point(s) along the path to yield a single measurement. The Sampled Points
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field determines the number of subintervals utilized by an Integration Method. There are two
Integration Methods:

• Uniform: Uses the midpoint of each uniformly spaced interval, defined by the number of
Sampled Points, to calculate spectra that are summed over the entire path. This method
requires more Sampled Points, the more the source-to-detector distance varies along a path
subsegment.

• MeanValue: Uses the mean value theorem of definite integrals to fmd the point along a
path subsegment that preserves the total count rate, if we moved along the subsegment
accounting for geometric attenuation (inverse square law). In most conditions a Sampled
Points equal to one is sufficient but in high count rate environments the modeling of pileup
effects may require more Sampled Points.

The final consideration is the Loop Order, which behaves just identically to the Loop Order on the
Batch tab. The paths do not appear as a Loop Order option, because all variations of the variables
to adjust occur within a path configuration. Additionally, there is no Write option, as on the Batch
tab, because Pass By relies on the summation of multiple injects for each path. However, the Pass
By setup can be saved to a ".bis" file and is automatically generated when the pass by is Run.
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11. GADRAS TOOLS

11.1. GADRAS Editors and Libraries

Editors for various libraries and properties can be found under the Tools menu option on the main
window, as shown in Figure 76. Editor options include:

• Deviation Pairs (discussed in Section 6.3)

• Isotope DB (discussed in Section 6.1.2)

• PhotoPeak List (discussed in Section 6.1.1)

• Source DB (Source database)

GADRAS 1$3.0 Benchmark\ BeRPball (Neutron: NPOD) El x

Detector Plot Time History Analyze Model Neutron Inject

Eigtois

Deviation Pairs

Isotope DB

PhotoPeak List

Source DB

Material Mgr

Spectrum Tools

Gam File Tools

Calcu lators

Dose Calc

Cross Sections

Distance Calc

Layout Arrangement

Flow Forms

Cascade Forms

Si d e-by-Si d e

Display Deviation Pair Editor

Display isotope Database Form

Display PhotoPeak List Form

Display Calibration Sources Editor

Display Material Management Form

Spectrum File Tools

Display Gam File Tools Form

Display Dosage Calculation Form

Get Cross Sections

Inverse Square Law

Flow layout visible forms

Cascade layout visible forms

Arrange forms side-by-side (Fal

GADRAS Functions

Rebin Tool

Template DB

Batch Peak

Migrate Resp.

Batch Migrate

F-Score

U Relative Eff

Tools Setu p

Generate a Rebin.dat file for the current detector

Create Template DB file (db.pcf)

Batch Peak Search Analysis

Migrate Current Detector Response

Batch Migrate Detector Response

Score Nuclide identification Algorithms

Uranium Relative Efficiency Tool

Figure 76. Tools Tab

11.1.1. (Calibrated) Source Database (DB)

Users can access the Source DB form from the Tools tab on the main window. This form displays
a database of known calibration sources with various properties. The source list is located in the
Source.lib file in the root GADRAS directory. When GADRAS is updated to a new version, user-
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added sources are automatically retained. Sources are added and identified according to their unique
Source ID.

Source DB includes the following information for each calibration source:

• Source ID —Naming convention: atomic weight followed by the elemental symbol (e.g.,
109Cd) + underscore + alphanumeric information (i.e., serial number or other identifying
information).

• Original Calibrated Activity

• Original Calibration Date

• Location

Calibration sources are grouped by radionuclide on the Source DB form. Clicking the tree-expand
button (the + to the left of each isotope name) allows the user to view all calibration sources for that
radionuclide. Users may edit or delete existing sources or add new sources using this form.

When computed spectra are compared with measurements, activities for stored calibration sources
are decay-corrected based on the Calibration Date, the Calibrated Activity, and the measurement
date of the plotted spectrum. An activity calculator is provided at the bottom of the window for
users to obtain decay-corrected activities for each source. Figure 77 illustrates a listing of calibration
sources for 109Cd and the activity calculator.
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Calibrated Source Database X

File

Isotope Source ID Calibrated Activity Calibration Date Location

-F 88Y

-F 905R

- 109CD

131651 101.89 uCi Aug 01, 2008 LANL

1429944 109.59 uCi May01, 2010 SRNL

1599152 9.8 uCi Jun 15, 2012 ORNL

16404819 8.92 uCi Jan 01, 2015 NG

1748511 31.46 uCi Aug 15, 2014 B NL

1748522 31.43 uCi Aug 15, 2014 LANL

17527 1.11 mCi Aug 01, 1986 SNL

202639 30.22 uCi Sep 11, 2014 SNL

322125 9.19 uCi Mar 22,2012 SPAWAR

H641 10.54 uCi Jul 01, 1998 LLNL

H661 9,9 uCi Jul 01, 1998

-F 110AGM

- 11R{N
v

Activity Calculator. 8/3/2018 At-levity: Half life (qc

Figure 77. Source DB Tool with a 109Cd Source Highlighted

11.1.2. Spectrum File Tools

GADRAS has the capability of manipulating spectra to perform desired tasks or calculations. This
may include adding or subtracting spectra, scaling a spectrum, applying Poisson statistics to a record,
or other calculations. The Spectrum Tools form is shown in Figure 78.
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4 SpectrumFileTools 0 X

Files i n DAGADRAS\Detector\Benchmark\BeRPball

0J010205.75423.PCF 8302fa5232623357db2b956ea67cdf7cacOb2d18.pd aident.n42
20130506_1_MPS.n42 a - Copy.spe ARound.pd
20130506_1_MPS.pd a.n42 ascTest.asc
3767777041c19907c133e3dda6a553df-F36520.pcf A.per Backgroundcompo
3cea610c1355aebbbcdfb26e16ce5749f0ba73370.pd a.spe BeRP1.per
496efa1993bed2elbd343d0c31234b66a3a0639c.pd A—.pcf BeRP1 AA 00 n42_ _ .

>

Eomples 1 History I

B.ASC=A Copy all records from A.pcf to B.ASC A

B,(1:5)=A.(61 Records 1:5 of B.pcF equals records 6:10 of A.pc1

C,1=A,5+13,9 C.pcF,1 equals A.pcF,5 + B.pcf,9 (spectrum counts and times added)

A,1=B,18LC,1 A1 equals sum of count rates of B,1 and C,1 (spectrum counts normalized to B,1 ti...

A,2= S u m (B, (1:4); CA) Sum records 1:4 of B.pcf and record 6 of C.pcF and assign to record 2 of A.per

A.3=A,1-A,2 A.pc1,3 equals A.pc1,1 stripped with A.pc1,2

B=A,5+6*2 B.pcF,1 equals A,pcF,5 plus twice A.per,6 (double meas, time, keep count rate)

B=A,5+6/2 B.pc1,1 equals A.pcf,5 plus half A.pcF,6 (halve meas. time, keep count rate)

A,9=A,4+(:8) A.pcF,9 equals the sum of records 4:3 of A.per

A,(1:3)=Scat(A) Apply Poisson Statistics to records 1:3 in A.pc1

B,(1:100)=Scat(A.1) Records 1:100 in B are Poisson-statistical samples of spectrum in A1 v

Command:

Batch Cancel Submit

Figure 78. Spectrum Tools Form

The Examples tab demonstrates the available functions in the spectrum tools form. To type a file
name at the current cursor location, the user may click the filename from the list box or manually
type the file. If a file name includes special characters such as spaces or operators (e.g. +, /, *), the
file name should be put in quotes (e.g. "my+spectrum.pcf This ensures the file name is not
misinterpreted as an operation. Clicking Submit sends the command to GADRAS. If it is a valid
command, it will appear in the History tab, otherwise, GADRAS will warn the user that the
command is invalid. Users can repeat a command by clicking on the command in the History tab.
To clear the History, the user may click Clear. Users may perform batch operations by writing
multiple commands on separate lines in a text file. When the user clicks Batch, they should select
the file with the commands GADRAS will perform the commands sequentially. If one of the
commands is invalid, GADRAS will inform the user which of the commands was invalid and which
commands were executed successfully. GADRAS will also inform the user if all the commands
were executed successfully.
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11.2. Calculators

11 .2.1. Dose Calculation

The expected dose (exposure) rate from almost any source can be calculated using GADRAS. This
calculation is independent of detector characteristics. However, GADRAS does compensate for

attenuation and scattering by intervening air. Based on methods specified in ANSI/ANS-6.1.1-1991,

"Neutron and Gamma-Ray Fluence-to-Dose Factors," effective dose equivalent rates for an
anthropomorphic representation of the human body can be calculated.

The Dose Calc button is located under the Tools tab on the main form. The radionuclide source
strength can be provided as activity (Curies) or mass (grams). Information needed for a dose
calculation includes the following:

• Preferred dose units: Select output units via drop-down menu (Rem or Sievert)

• Source (radionuclide and source strength): Radioactive source information (e.g., "137Cs,
100uC"; a known source from Source DB; or a model file name)

• Distance: source-to-detector distance (cm)

• Gamma Energy Threshold (optional): any gamma emissions below the specified
threshold energy (keV) are excluded when the gross leakage is tallied. This only affects the
gross leakage, not the computed dose.

The following calculated rates are shown in Figure 79:

• Gamma Dose
• Neutron Dose

• Total Dose

• Gross Leakage (gamma)

• Gross Leakage (neutron)
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Dose (based on ANWANS-6.1.1-1991)

Preferred Dose Units

X

Setup
CD Source 0 Measurement

Source:

Distance (cm):

BeRPBare-SteelCarts

100

Computed Do5e Rate (milli-Rem/hr)

Gamma Dose:

Neutron Dose:

Total Dose:

0.691

0.4

1.1

Gross Leakage (gammas/neutrons per second)

Gamma Threshold (Ice"):

Gamma:

Neutron:

44

0E+00

0E+00

Figure 79. Dose Calculation Tool

11.2.2. Distance Calculator

The distance calculator uses dose rates taken at two different positions to estimate the distance to
the source. This can be useful if the source is inside a large container and the exact position is
unknown. This form uses ratios of dose rates and distances, so units are arbitrary as long as they are
consistent. An example of the form can be seen in Figure 80.
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Distance (inverse law) Calculator X

Units are arbitrary but must be consistent

Measurement 1

Measurement 2

Dose Rate

Distance

from Ref. Pt.

Distance
to Source

Scatter Environment

0 No Scatter (photopeak count rate)

0 Mid Scatter
0 High Scatter

Power Law: 2

Figure 80. Distance Calculator Tool

The Distance from Ref. Pt. should be entered as a distance from a consistent position that is in
line with the source (i.e. the source and the two measurements should form a line and the distances
should be entered from an arbitrary point on the line). One caveat is that if the source is not in line
with the two measurement points, the resulting position may not be accurate.

The scatter environment can impact the dose rate measurements. Because of this, the distance
calculator gives users the option to estimate the scatter environment. Most of the time, users should
use the Mid Scatter option (Power Law: 1.85). Low Scatter (Power Law: 2.0) should be used when
the floor is very thin or non-existent and there are no walls nearby. High Scatter (Power Law: 1.65)
should be used when the measurement is taken in a compact area, such as a vehicle. Users also have
the option of specifying their own Power Law if this value is known.

11.3. Other Tools

11 .3.1. Rebin Tool

The rebin tool creates a file called Rebin.dat for a particular detector. This tool should be used when
users want to rebin a spectrum into a specific energy bin structure. The form can be seen in Figure
81.
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Create Rebin Data X

Parameters

Minimum Energy

Maximum Energy

20

0 Continuum Resolution

keV Energy Power

keV Minimum Channel Width

defined in Photon.lis

3

❑ Narrow bins around peaks

Peak Resolution ::•.1

0 Number of Channels

0.5

keV

Generate Data

Close

Figure 81. Rebin Tool

The Minimum Energy should be the energy of the low edge of channel O. Maximum Energy
should be the energy of the upper edge of the maximum channel. The Energy Power and Zero
Intercept fields are used to determine the bin width as a function of energy. To have uniform bins
in the continuum, the Energy Power should be O. The bin width will be determined by the
minimum and maximum energies, as well as the number of channels. In Figure 81, the bin width will
increase as the square root of the energy, and the channel corresponding to 0 keV will have a bin
width of 1 keV.

Users may define the number of channels in two ways. By selecting the Number of Channels
option, users can define the total number of channels to use. The continuum and peaks will have the
same binning structure. If Continuum Resolution is selected, users can specify separate bin widths
for the continuum and the peaks. The Continuum Resolution textbox defines the bin width as a
percentage of energy at 661 keV. The bin width AE (keV) for the continuum is determined using

AE = - P EP +E0

where E is the bin lower energy bound in keV, C is the Continuum Resolution (at 661 keV) in keV,

P is the Energy Power, E0 is the Zero Intercept in keV. For example, in Figure 81, the Zero
Intercept is 1 keV, the Energy Power is 0.5, and the Continuum Resolution is 3%. Therefore, at
1000 keV, the bin width is 25.4 keV. By default, the continuum resolution is also used for energy
bins containing peaks. If the "Narrow bins around peaks defined in Photon.lis" checkbox is
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checked, users can define a different bin structure around peaks. Photon.lis is stored in the root
GADRAS data directory (default is C: \ GADRAS) and is universal for all detectors. Users can

modify this file to include peaks they wish to have more bins in or remove peaks they wish to

ignore. An example of the Photon.lis file can be seen in Figure 82.

Photon.lis - Notepad

File Edit Format View Help

a I [mu.]

29.46
29.78
30.62

133Xem
133Xem
133Xe

16.20
29.90
14.40

6.25
11. 79
5.42 I I

30.97 133Xe 26. 50 10. 20
38.66 239Pu 0. 01 24. 80
39.52 152Eu 21. 10 7. 96
40.12 152Eu 38. 30 14. 89
40.90 1535m 17. 90 15. 63
41.54 1535m 32. 20 29. 00
45.24 24DPu O. 05 166. 67
48.22 166Ho 3. 02 29. 08
49.12 166Ho 5. 35 53.45
51.62 239Pu 0. 03 114. 09
55.48 166Ho 56 7.12
55.67 166Ho 1. 08 13. 86
56.83 239Pu 0.00 5. 77
59.54 241Am 35. 90 166. 67
63.29 238u 4. 80 133. 63
68.89 201T1 26. 90 92. 22
69.67 1535m 4. 85 12. 29
70.82 201T1 46. 00 166. 67
72.80 Pb x-ray 29. 19 29.19
74.80 Bi x-ray 29. 19 29.19
74.81 232Th 10. 50 6.10
75.00 Pb x-ray 49. 19 49.19
77.10 Bi x-ray 49. 19 49.19
77.11 226Ra 8. 00 7. 64
77.11 232Th 17. 70 10. 93
80.12 201T1 16.10 74. 66

Figure 82. Photon.lis File

To modify this file, users can input the energy in the first column, the nuclide name in the second

column, the absolute yield (%) in the third column, and the detectability (based on energy and yield)

in the fourth column. The Rebin tool only reads the first column; the rest of the columns are

ignored. Only peaks within the specified energy range will be used. The default file is sorted by

energy, but users may input peaks in any order. Users may select a constant bin width for peaks, or

may use the percent of the peak's energy as the bin width basis. The Rebin tool will assign one bin

to the peak with a width corresponding to the specified energy or percentage of peak energy. If the

annihilation peak at 511 keV is specified, the bin width is extended by 3 keV due to Doppler

broadening of the peak.

Once the parameters are filled in, users can click the Generate Data button to create the Rebin.dat

file. The information textbox will be populated (Figure 83). The number of channels will be

displayed first, followed by the energy bins. This information is recorded in Rebin.dat. When the

Rebin.dat file is present in the detector directory, the Rebin checkbox on the Detector tab will be

enabled. Users can choose whether they want the plotted spectrum to be rebinned according to the

Rebin.dat file by checking this box.
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Create Rebin Data X

Parameters

Minimum Energy

Maximum Energy

20

3000

0 Continuum Resolution

keV Energy Power

keV Minimum Channel Width

defined in Photon.lis

3

2 Narrow bins around peaks

Peak Resolution 4,1

0 Number of Channels 128

0.5

1 keV

Generate Data

1435 A

20.00 29.39 29.53 29,71 29.85 30.55 30.69
30.90 31.04 34.81 3358 38.74 39.44 39.60
40.04 40.20 40.82 40.98 41.46 41.62 45.15
45.33 43.13 48.31 49.03 49.21 51.53 51.71
55,33 5557 55,77 56,73 56,93 59.44 59,64
63.19 63.39 68.78 69.00 69.56 69.78 70.71
70.93 72.69 72.91 74.69 74.81 74.90 75.11

Close

Figure 83. Rebin Data Tool with Data Generated

11.3.2. Batch Peak Search

Users can perform a peak search on multiple files by using the Batch Peak Search tool (Figure 84).
Users can select which files they want to analyze by clicking the Choose Files button. In Figure 84,
all files in the current detector directory ending in .pcf will be analyzed. The Threshold (Sigmas)
textbox defines how far above the continuum a peak must be to be included in the results. After the
files are chosen and the threshold is specified, clicking OK will start the analysis.
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Batch Peak Search ❑ X

Threshold (Sigmas) 5.0

Choose Files

Figure 84. Batch Peak Search Tool

The tool will sequentially analyze all spectra in each of the files specified by the filter. The results will
be stored in .csv files which are located in the Temp directory (default is C: \ GADRAS \Temp).
These files can be opened in Excel. The following data is stored in the csv file:

• Energy (keV)
• Energy uncertainty (sigma)

• Count Rate (counts per second)

• Count Rate uncertainty (sigma)

• Full-Width at Half Max (keV)

• FWHM uncertainty (sigma)

• Leakage (photons per second)
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12. GADRAS SETTINGS

GADRAS has some settings that users can modify to customize the user interface. These options
consist of:

• Change plot options on detector change (default on): GADRAS will change the plot style of
the first spectrum depending on if the detector is high resolution (e.g. HPGe) or low
resolution (e.g. NaI)

• Automatically update plot when fields change (default off): with this turned on, users can
update the spectrum viewer automatically when they change any field on the Plot tab
(Foreground, Background, Compute Source term)

• Don't show energy calibration dialog (default off): when doing the graphical energy
calibration (Section 6.2), this option determines whether GADRAS will automatically ask
which calibration parameter to adjust

• Adjust plot scale with mouse wheel (default on): if selected, the mouse wheel will adjust the
y-axis scale on the spectrum viewer; if not selected, the mouse wheel will zoom in

• Animate zoom (default on): if selected, the spectrum viewer will zoom in with an animation

• Open ROI in new window (default off): if selected, zooming in will open a new spectrum
viewer with the zoomed spectrum; otherwise, the zoom will remain on the same window

• Reset Dialogs button: when pressed, this reset the GUI to show all dialog boxes until user
checks the option to not show the dialog again

• Save DLL Log button: if GADRAS functions incorrectly, this button can be used to save
the error to a file

• Exit splash screen upon load (default off): checking this will exit the initial GADRAS splash
screen as soon as GADRAS is ready for user interaction, otherwise it will stay visible for a
full three seconds

• Turn off autocomplete (default off): the Computed Source line on the Plot tab has an
autocomplete feature; if desired, this functionality can be turned off

• Rebin spectra when inserting to files (default off): if checked, spectra will be rebinned
according to the Rebin.dat file structure (Section 11.3.1) whenever they are added to a PCF
file via the PCF Viewer
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